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CorelDRAW Graphics Suite X7.

Chapter-1. What Is CorelDraw? Corel draw is an application or popular drawing software
and use to create visiting card, logo, banner, poster, holding, Boucher etc. And use to print
media. And many more types of designs. You can make in coral draw.
CorelDraw (styled CorelDraw) is a vector graphics editor developed and marketed by Corel
Corporation. It is also the name of Corel’s graphics suite, which bundles CorelDraw with
bitmap-image editor Corel.

Extensions Name of CorelDraw File. .CDR (CorelDraw.).

How to Open CorelDraw Software?

Click on Start Button > Programs > CorelDraw Folder > CorelDraw X7.
Click on Window Button > Search > Type > CorelDrawX7. > Enter,

Double Click on \3' CorelDraw. Icon on Desktop.

(oA
M)

Title Bar. A horizontal bar at the top of a window, bearing the name of the program and
typically the name of the currently active document include three button minimize, maximize
and close button. Or display the title of the open document.

Menu Bar. Corel customization features let you modify the menu bar and the menus it
contains. You can change the order of menus and menu commands; add, remove, and rename
menus and menu commands. You can search for a menu command if you do not remember
the menu in which it belongs. You can also reset menus to the default setting. The
customization options apply to the menu bar menus as well as to shortcut menus that you
access by right-clicking.

Tool Box. The toolbox contains tools for drawing and editing images. Some of the tools are
visible by default, while others are grouped in flyouts. Flyouts open to display a set of related
CorelDraw tools. A small flyout arrow in the lower-right corner of a toolbox button indicates
a flyout. You can access the tools in a flyout by clicking the flyout arrow. After you open a
flyout, you can easily scan the contents of other flyouts by hovering over any of the toolbox
buttons which have flyout arrows. Flyouts function like toolbars when you drag them away
from the toolbox. This lets you view all the related tools while you work.

Document Tab. A tab displays for each open document to allow you to quickly move between
documents.

Update Text Toolbar. A temporary toolbar that allows you to update documents created in
CorelDraw X7 (or earlier) in order to edit the text.

Drawing Window. The area outside the drawing page bordered by the scroll bars and
application controls.
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Property Bar. A detachable bar with commands that relate to the active tool or object. For
example, when the text tool is active, the text property bar displays commands that create and
edit text.

Docker. A window containing available commands and settings relevant to a specific tool or
task.

Rulers. Horizontal and vertical borders that are used to determine the size and position of
objects in a drawing.

Document Palette. A dockable bar that contains color swatches for the current document.

Document Navigator. The area at the bottom left of the application window that contains
controls for moving between pages and adding pages.

Drawing Page. The rectangular area inside the drawing window. It is the printable area of
your work area.

Status Bar. An area at the bottom of the application window that contains information about
object properties such as type, size, color, fill, and resolution. The status bar also shows the
current cursor position.

Navigator. A button at the lower-right corner that opens a smaller display to help you move
around a drawing.

Color Palette. A dockable bar that contains color swatches.

Welcome Screen. The Welcome screen gives you easy access to application resources and
lets you quickly complete common tasks, such as opening files and starting files from
templates. You can also find out about the new features in CorelDraw Graphics Suite X7 and
get inspired by graphic designs featured on the Gallery page. In addition, you can access videos
and tips, receive the latest product updates, and check your membership or subscription.

Y CorelDRAW X8 (64-Bit) - Welcome Screen E - | X
File Tools Window Help

f G- ] 100} - o =B~

# Welcome Screen Hints.

Get Started

sanadoid afap §© - auy ¥

GRLQR M

New Document I ~

New From Template

Open Other...

e 1900

Take a Tour

Cursor Position  + Object Information x> Finl Coler £ < outline Color




Vinod Computer Institute Mehnagar Azamgarh UP.

Workspace Selection. CorelDraw includes a collection of specialized workspaces that are
designed to help you increase your productivity. A workspace is a configuration of settings
that specifies how the various command bars, commands, and buttons are arranged when you
open the application. You can choose a workspace from the Welcome Screen that displays
when you first launch the application or you can switch to a different workspace from within
the application.
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Chapter-2. CorelDraw X7 Toolbox.

Many of tools in the CorelDraw are organize in flyouts. To access such tools click the small
arrow in the lower right corner of a button. The illustration below show the toolbox and flyouts
available in the Default workspace, and can help you find tools easily. If you still don’t see the
tool you are looking for, click the quick customize at the bottom of the toolbox. With the help
of the quick customize button, you can also hide tools you don’t use often.
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CorelDrawX7 Tools?
L g o000 <N 08B NS @ U H

m Pick Tool. You select objects by using the Pick tool. By default, all objects are treated as
filled so that you can select any unfilled object by clicking on its outline or the area surrounded
by the outline. However, you can change this default behavior so that you can select unfilled
objects only by clicking on their outlines. Changing the default behavior is useful when you
work with line drawings and often need to select objects that appear beneath other objects.
CorelDraw lets you select text to edit specific characters or modify it as an object. For example,
you can select specific characters to change the font or select a text object, such as a text frame,
SO you can move, resize, or rotate it.
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Freehand Pick. To move an object, drag it. To constrain the movement to the horizontal
or vertical axis, hold down ctrl while to scale the object, drag one of the corner sizing handles,

holding down shift if you want to scale from the center. Dragging. The freehand pick tool lets
you select objects by using a freehand selection marquee.

Free Transform Tool. The free transform tool lets you transform an object by using the
free rotation, free angle reflection, free scale, and free skew tools. Rotate the object by
positioning the axis and then dragging a rotation handle.
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Free Rotation. To rotate a selected object around a fixed point, click the free rotation tool
button on the property bar, click in the drawing window to fix the anchor point, and then drag.
To choose a different free transform mode, click one of the following buttons on the property
bar.

Free Angle Reflection. Free angle reflection tool button lets you scale a selected object,
or mirror it horizontally or vertically. Mirror the objects by positioning the reflection axis and
then dragging in a circular motions.

.| Free Scale. Free scale tool button lets you resize a selected object by scaling it along the
horizontal and vertical axes simultaneously, relative to its anchor point. Change the objects
dimensions by positioning the scaling center point and the dragging.

Free Skew. Free skew tool button lets you skew a horizontal and vertical lines of an object
simultaneously, relative to its anchor point. Slant the objects by positioning the skewing axis
and dragging.

Shape Tool. (F10). CorelDraw X7 offers enhanced node selection that simplifies working
with complex shapes. You can now select adjacent nodes on curves by using the Shape tool
while holding down Shift. You can also change the direction in which the nodes are selected.
Edit a curve objects or text character by manipulating nodes. The shape of every vector object
in CoreIDRAW is controlled by nodes. Lines run from node to node. Curved lines are built
from curve nodes. Curve nodes have two "arms"”, which guide the curves. The arms point in
the direction in which the curve leaves the node.
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Smooth. The smooth tool lets you smooth curved objects to remove jagged edges and
reduce the number of nodes. To change the nib size, type a value in the nib size box on the
property bar, and press enter. To set the speed at which the smoothing effect is applied, type a
value in the rate box, and press enter.

Smear. The smear tool lets you shape an object by pulling extensions or making indents
along its outline. To smear the outside of an object, click inside an object, close to its edge,
and drag outwards. To smear the inside of a selected object, click outside an object, close to
its edge, and drag inwards.
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Twirl. The twirl tool lets you create swirl effects by dragging along the edge of objects.
Click the edge of an object, and hold down until the twirl is the size you want. To position and
reshape the twirl, drag while holding down the mouse button. To set the speed at which the
twirl effect is applied, type a value in the rate box, and press enter. To set the direction of the

twirl effect, click the counterclockwise twirl button or the clockwise twirl button the property
bar.
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Attract. The attract tool lets you shape objects by attracting nodes to the cursor. Click
inside or outside a selected object, close to its edge, and hold down to reshape the edge. For a
more pronounced effect, drag while holding down the mouse button. To change the nib size,
type a value in the nib size box on the property bar, and then press enter.

Repel. The repel tool lets you shape objects by pushing away nodes from the cursor. Click
inside or outside a selected object, close to its edge, and hold down the mouse button to reshape
the edge. For a more pronounced effect, drag while holding down the mouse button. To change
the nib size, type a value in the nib size box on the property bar, and then press enter.

Smudge. The smudge tool lets you distort a vector object by dragging along its outline.
To smudge the inside of a selected object, click the outside of the object and drag inward. To
smudge the outside of a selected object, click the inside of the object and drag outward.
Smudging and smearing let you shape an object by pulling extensions or making indents along
its outline. With smudging, the extensions and indents resemble streaks that very little in width
as you drag with the Smudge brush tool. With smearing, the extensions and indents have a
more fluid shape that decreases in width as you drag with the Smear tool.

1l1|Page


javascript:WWHClickedPopup('CorelDRAW_Help',%20'CorelDRAW-Glossary.html#wp1687370');

Vinod Computer Institute Mehnagar Azamgarh UP.

ﬂ CorelDRAW X8 (64-Bit) - D:\Book of The Corel Draw X8 -2016,\safi corel menu\s.cdr @? - [ X
File Edit \View Layout Object Fffects Bitmaps Text Table Tools Window Help
FH-@4 FBlk - B my o |- B2 senk- & F-
Slooker |2 glo 2 4500 2 ALY
h & Smearcdr  sadsdd.cdr sertedr  siedr Hints »
4 7
m Q» Shape 0 access newer features, text must be updated. Update (7] x HINTS I:::rn ![
16 44 12 40 38 36 £l 32 30 28 2 = &
Smooth R P . . R . . R | o i L . . =
Jl-'i-‘ g" Smoo #~ Smudging objects
- Smear o
Q ﬂ Smudge brush tool
@ Twirl o
D> Attract « To smudge the inside of a selected object, T
4 click the cutside of the object and drag fast
W 1> Repel inward. E]
&
m = To smudge the outside of a selected object, 2'
I:L 'ﬁJ Roughen click the inside of the object and drag = .
outward.
©) H
4l o | =
N o
5:{‘ Q g =
A, 1 Outline Change In Vector Shape 4
By Using The Smudge BrushTool 3
@ a
= ]
7. B
QL = Learn more .
@ Smudging and smearing
? objects
/‘ = .
Help topic
| v
] 1 of 1 1] Pagel1 / < > &
> f @
(-50382,24.500) ¥ Curve on Layer 1 &5 Fountain &l croomov0 ko 8000 pt

sl e IR .. . .. "%,

Roughen. The roughen tool lets you distort the outline of a vector object by dragging
along the outline. To roughen a selected object, point to the area on the outline you want to
roughen, and then drag the outline to distort it. To change the nib size, type a value in the nib
size box on the property bar, and then press enter.
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Crop Tool. The crop tool lets you remove unwanted areas in objects. To crop selected
objects, drag to define the protected area. You can use the crop tool on both bitmap and vector
objects. To rotate the protected area, click it, and then drag a rotation handle. To crop the
selected objects to the protected area, double-click the protected area.

PNBOD N> 00002

12|Page



Vinod Computer Institute Mehnagar Azamgarh UP.

ﬂ CorelDRAW X8 (64-Bit) - D:\Book of The Corel Draw X& -2016)\Tools lcons\Crop Tools.cdr E? - [ X
File Edit \View Layout Object Fffects Bitmaps Text Table Tools Window Help
PH-@8 FBE O- B my 5% |- W LB swh- O B-
X:|-65.876 " we 7215"
0| .0
¥:[22.785 " I 7461 o 00 E
‘ A& Welcome Screen Untitled-1 Crop Tools.cdr ce.cdr ccenn.cdr Hints »
4 2
Update text - To access newer features, text must be updated. Update 9 X Leam ~ L
tv, HINTS more z
3 i £ ¥ .. F R . . . N s B
4| fcrop - #  Cropping ohjects
Q ? Knife J|:ll_cr\:||:t tool %
P
. i Virtusl Segment Delete +To crop selected objects, drag to define ‘g
ey M Eraser the protected area. :1;
rb | *¥ou can use the Crop tool on both bitmap =
] and vector objects. 2
] =
o L
71 -
sl
o) g
A | 5
3
N You Can Crop Bitmap Image And Text Matter 2 L
<. Has Been Selected By Using The Crop Tool.
.\I‘ = To rotate the protected area, click it, and
’ then drag a retation handle.
] N
By ]
2
i . v
|14 4101 b pi@ | Pagel < e
- B
(-60.606,27.235) » 1aaal jpg (RGB) on Layer 113188 dpi &> None

02-12-2016

Knife Tool. The knife tool lets you slice objects, groups of objects, and bitmaps along any
path you specify. To split an object along a straight line, click the 2-point line mode button on
the property bar, and drag across the object. To split an object along a freehand line, click the
freehand mode button on the property bar, and drag across the object.
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Virtual Segment Delete. The virtual segment delete tool lets you delete portions of
objects that are between intersections. To delete a virtual line segment, move the pointer to the
line segment you want to delete, and then click the line segment. To delete multiple line
segments at one time, drag a marquee around all line segments that you want to delete. Hold
down ctrl to constrain the marquee to a square.

@ Eraser Tool. The eraser tool lets you remove areas of your drawing. To erase part of a
selected object, drag where you want to erase. To change the thickness of the nib, hold down
shift and drag up to increase the nib size or down to decrease the nib size.
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Zoom In (Ctrl++). Increase the magnification level to view more details. You can change
the view of a drawing by zooming in to get a closer look or by zooming out to see more of the
drawing. You can experiment with a variety of zoom options to determine the amount of detail
you want. Panning and scrolling are two additional ways to view specific areas of a drawing.

Zoom Out (F3). Decrease the magnification level to view a larger portions of document.

Zoom To Select (Shift+F2). Magnify only the selected object.

Zoom To All Objects (F4). Adjust the magnification level to include all objects.

Zoom To Page (Shift+F4). Adjust the magnification level to fit the entire page.

Zoom To Page Width. Adjust the magnification level to fit the entire page width.

Zoom To Page Height. Adjust the magnification level to fit the entire page height.
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@ Pan Tool. (H). The pan tool lets you control which part of the drawing is visible in the
drawing window. To view a different part of the page, drag anywhere on the page. Drag hidden
areas of a drawing view without changing the zoom changing.
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Freehand. (F5). The Freehand tool lets you draw single line segments and curves. To
draw a straight line, click where you want the line to begin, and then click where you want it
to end. Draw curve and straight line segments.
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2-Point Line. The 2-point line tool lets you draw a straight two-point line segment. To
draw a straight line, point to where you want to start the line, and drag to draw the line. To add
a line segment to a selected line, point to the end node of a selected line, and drag to draw the
line. Drag straight line by drawing from the starting point to endpoint.

Bezier Tool. The Bezier tool lets you draw curves one segment at a time. To draw a
straight line, point to where you want to end the line, and then click. To draw a curve, drag to
define it, holding down ctrl if you want to constrain the curve to 15-degree increments.

Pen Tool. The pen tool lets you draw curves one segment at a time. To draw a curved
segment, click where you want to place the first node, and then drag the control handle to
where you want to place the next node. Release the mouse button, and then drag the control
handle to create the curve you want. To draw a straight segment, click where you want to start
the line segment, and then click where you want to end it.
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B-Spline Tool. The b-spline tool lets you draw curved lines by setting control points that
shape the curve without breaking it into segments. To draw a b-spline, click where you want
to start the line, then click to set as many control points as you need to shape your line. To
delete a control point, select the line by using the shape tool, and double-click the control point
that you want to delete.

Polyline Tool. The polyline tool lets you draw lines and curves in preview mode. To draw
a straight segment, click where you want to start the line segment, and then click where you
want to end it. To draw a curved segment, click where you want to start the segment, and then
drag across the drawing page.

3-Point Curve Tool. The 3-point curve tool lets you draw a curve by defining the start,
end, and center points. To define the start and end points of the curve, click where you want
to start the curve, and then drag to where you want the curve to end. To define the center point
of the curve, release the mouse button, and then click where you want the center of the curve
to be.
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Smart Drawing (Shift+S). The smart drawing tool converts your freehand strokes to
basic shapes and smoothed curves. To draw a shape or a line by using shape recognition, draw
a shape or a line in the drawing window. To specify shape recognition settings, use the property
bar.
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Artistic Media. (1). The artistic media tool provides access to the preset, brush, sprayer,
calligraphic, and pressure tools. To draw with the artistic media tool, drag along the path you
want, as with a pencil on paper. To specify settings for the drawing mode you’ve chosen, use
the controls on the property bar.

Preset. Draw a curve by using preset vector shape.

El Brush. Draw a curve that resemble a painted brush stroke.
Sprayer. Draw by spraying a series of preset images.
Calligraphic. Draw a curve that resemble a calligraphic pen stroke.

Pressure. Mimic the effects of drawing with a pressure sensitive pen.
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@ Rectangle Tool. (F6). The rectangle tool lets you draw rectangles and squares. To draw a
rectangle, drag where you want to place it. Holding down ctrl draws a square, while holding
down shift draws from the center. Draw squire and rectangles by dragging in the drawing
window.
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3-Point Rectangle Tool. The 3-point rectangle tool lets you draw rectangles at an angle.
To define the baseline of the rectangle, drag to draw the width, and then release the mouse
button. (To constrain the angle of the baseline to 15-degree increments, hold down ctrl as you
drag.) To define the height of the rectangle, move the pointer to draw the height, and then
click. (Hold down ctrl to draw a square.).
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Ellipse Tool. (F7). The ellipse tool lets you draw ellipses and circles. To draw an ellipse,
drag where you want to place it. Holding down ctrl draws a circle, while holding down shift
draws from the center. Draw circle and ellipse by dragging in the drawing window.
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3-Point Ellipse. The 3-point ellipse tool lets you draw ellipses at an angle. To define the
width of the ellipse, drag to draw the centerline of the ellipse at the angle you want, and then
release the mouse button. To define the height of the ellipse, move the pointer, and then click.
(Hold down ctrl to draw a circle.).

@ Polygon Tool. (Y). The polygon tool lets you draw symmetrical polygons and stars. To
draw a polygon, drag where you want to place it, holding down ctrl if you want to draw a
polygon with equal sides. To adjust the number of sides or points on a selected polygon, type

a value in the number of points or side on polygon, star and complex star box on the property
bar.
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Star Tool. The Star tool lets you draw perfect stars. To draw a perfect star, drag where
you want to place it, holding down “Ctrl” if you want to draw a perfect star with equal sides.
To adjust the number of sides or points on a selected star, type a value in the Points or sides
box on the property bar. To adjust the sharpness of a selected star, type a value in the sharpness
box on the property bar.
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@ Complex Star Tool. The complex star tool lets you draw complex stars that have
intersecting sides. To draw a complex star, drag where you want to place it, holding down
“ctrl” if you want to draw a complex star with equal sides. To adjust the number of sides or
points on a selected star, type a value in the points or sides box on the property bar. To adjust
the sharpness of a selected star, type a value in the sharpness box on the property bar.
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Graph Paper. (D). The graph paper tool lets you draw a grid of lines similar to that on
graph paper. To draw a grid, use the controls on the property bar to set the number of columns
and rows, and drag in the drawing window where you want to place the grid. To make the
outer boundary a square, hold down ctrl while dragging.
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Spiral Tool. (A). The spiral tool lets you draw symmetrical and logarithmic spirals. To
draw a spiral, choose a spiral type from the property bar by clicking the symmetrical spiral
button or the logarithmic spiral button, and then drag in the drawing window where you want
to place the spiral. To specify the tightness of a spiral, type a value in the spiral revolutions
box on the property bar.

ﬂCore\DRAWXB(M—B\t]—D:\BookofTheCoreI Draw X8 -2016,\safi corel menu\Backup_of_Backup_of_swe.cdr |1f - [ X
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help
(FH-@ a4 P kg 5 B LMy o - m B[R s O -
@4 e e 100 & eopt - —_ = s
X -62.572" w4 5,547 " 1000 |% £]-62.572" | =00 o .
[ o % g = ot @ »
4 EE ¥:|32.139" i|5.288" 1000 |% Q0o {2(32.139 " B & I oo 2 68 8
Q‘A ﬁWe\comEScreen Untitled-1 Backup_of_Backup_of ... Hints.
B
4 Updatetext - To access newer features, text must be updated. Update (7] x Learn LK
. HINTS rmore =
Qe _®. e, e e e e o 0w 7 0w % % 8, e 7
i | ~ Drawing spirals
+ ; i3
Spiral toc/
[i2% @ piral too o
(b « To draw a spiral, choose a spiral type from the E'
| property bar by clicking the Symmetrical ;
D‘ spiral button @ or the Logarithmic spiral .g
o
i i =
O‘ button ‘@ and then drag in the drawing 7

window where you want to place the spiral.

D Polygon
¥ Star

I+ Complex Star

Design A Spiral Has Been Created @
By Using The Spiral Tool. R\a

-
I
n [ @
= To specify the tightness of a spiral, type 2
value in the Spiral revolutions box on the
property bar.

Jafieuepy 1afqo ;B

asic Shapes

B
Arrow Shapes

E ?_p Flowchart Shapes » To change the spiral’s shape, click the Shape
% Bapner Shapes toel i\-’
}‘ [ Callout Shapes See Moving, scaling, and stretching objects or
Q‘ Reotating and skewing objects for information
L] on transforming this object.
2 a
Learn more

? Drawing spirals
| .
s Help topic

23|Page




Vinod Computer Institute Mehnagar Azamgarh UP.

Basic_Shape Tool. The basic shapes tool lets you choose from a full set of shapes,
including hexagram, a smiley face, and a right-angle triangle. To draw a basic shape, choose
a shape from the perfect shapes picker on the property bar, and then drag in the drawing
window until the shape is the size you want.
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@ Arrow Shape Tool. The arrow shapes tool lets you draw arrows of various shape,
direction, and number of heads. To draw an arrow shape, choose a shape from the perfect
shapes picker on the property bar, and then drag in the drawing window until the shape is the
size you want.

Elowchart Shapes Tool. The flowchart shapes tool lets you draw flowchart symbols. To
draw a flowchart shape, choose a shape from the perfect shapes picker on the property bar,
and then drag in the drawing window until the shape is the size you want.

Banner Shapes Tool. The banner shapes tool lets you draw ribbon objects and explosion
shapes. To draw a banner shape, choose a shape from the perfect shapes picker on the property
bar, and then drag in the drawing window until the shape is the size you want.
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@ Callout Shapes Tool. The callout shapes tool lets you draw callouts and labels. To draw
a callout shape, choose a shape from the perfect shapes picker on the property bar, and then
drag in the drawing window until the shape is the size you want.

Text Tool. (F8). The text tool lets you type words directly on the screen as artistic or
paragraph text. To change the font of selected text, choose a new font from the font list box
on the property bar. To change both the size of a paragraph text frame and the spacing of text
simultaneously, position the pointer over the horizontal or vertical size handle for the frame,
and then drag.
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Table Tool. The table tool lets you draw and edit tables. To add a table to a drawing, click
the table tool, type values in the rows and columns boxes on the property bar, and then drag
diagonally to draw the table. To modify the table border, click the border selection button on
the property bar, choose the lines you want to modify, and then choose a line width from the
width list box.
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+ To split a selected row, click Table, Split into
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Parallel Dimension Tool. The parallel dimension tool lets you draw slanted dimension
lines. To draw a parallel dimension line, click the point where you want to the start the line,
and drag to where you want to place the endpoint of the dimension line. Release the mouse,
then move the pointer horizontally or vertically to position the dimension line.

Horizontal or Vertical Dimension Tool. The Horizontal or vertical dimension tool lets
you draw horizontal or vertical dimension lines. To draw a vertical or horizontal dimension
line, click the point where you want to the start the line, and drag to where you want to place
the endpoint of the dimension line. Release the mouse, and move the pointer vertically or
horizontally to position the dimension line.

Angular Dimension Tool. The angular dimension tool lets you draw angular dimension
lines. To draw an angular dimension line, click where you want the two lines that measure the
angle to intersect. Release the mouse, and position the pointer where you want the second line
to end.

Segment Dimension Tool. The segment dimension tool lets you display the distance
between end nodes in single or multiple segments. To draw a segment dimension line, click
anywhere along the segment that you want to measure. Move the pointer to where you want
to position the dimension line.

3-Point Callout Dimension Tool. The 3-point callout tool lets you draw a callout with a
two-segment leader line. To draw a callout line, click where you want to place the arrowhead.
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Drag the pointer to where you want to end the first line segment. Release the mouse, and then
click to end the second line segment.

Straight Line Connector Tool. The straight-line connector tool lets you draw a straight

connector line. To draw a straight connector line, drag from an anchor point on the first object
to an anchor point on the second object. To change the position of a connector line, select a
line by using the shape tool, and drag the node to a new location.

Right Angle Connector Tool. The right-angle connector tool lets you draw a right angle
connector line. To draw a right-angled connector line, drag from an anchor point on the first
object to an anchor point on the second object. To change the position of a connector line,
select a line by using the shape tool, and drag the node to a new location.

Rounded Right Angle Connector Tool. The rounded right-angle connector tool lets you
draw a right-angle connector line with curved corners. To draw a right-angled round connector
line, drag from an anchor point on the first object to an anchor point on the second object. To
change the position of a connector line, select a line by using the shape tool, and drag the node
to a new location.

Edit Anchor Tool. The edit anchor tool lets you modify connector line anchor points. To
add an anchor point to an object, double-click anywhere on an object. To move the anchor
point anywhere along the perimeter of an object, drag the anchor point to another point on the
perimeter. To delete an anchor point, click the anchor point that you want to delete, then click
the delete anchor button on the property bar.

Drop Shadow Tool. The drop shadow tool lets you apply a drop shadow to an object. To
add a drop shadow, click the object, and then drag from the first object to where you want to
place the shadow. To change the perspective of the drop shadow, drag the start handle. To
change the direction of the drop shadow, drag the end handle. To adjust the opacity of the drop
shadow, move the slider. To change the color of the drop shadow, drag a color from the color
palette to the end handle. You can also adjust drop shadows by using the controls on the
property bar.

Contour Tool. The contour tool lets you apply a contour to an object. To contour an
object, click the object, and then drag the start handle towards its center (to create an inside
contour) or away from it (to create an outside contour). To adjust the number of steps and the
degree of offset in the contour, move the slider. To change the outline color for the contour,
drag a color from the color palette to the diamond-shaped handle. To change the fill color for
the contour, drag a color from the color palette to the square handle. You can also adjust
contours by using the controls on the property bar. To edit the contours with the text still
selected, go to Arrange and select Break Contour Apart. Now with the text still selected after
breaking the contours, go to arrangement and select Ungroup All. Now we can set the color
for each of the contours.

27|Page




Vinod Computer Institute Mehnagar Azamgarh UP.

o4
i

+,
Q,
+ ¥
L
L
o
Q.
DA e
Alel
2
.
O Drop Shadow
E Contour
Blend
2, Distort
Q‘ Envelope
Extrude
2

hﬂa
i

This Text Matter Shadow Has Been
Created By Using Drop Shadow Tool

Adding drop shadows

gl Drop shadow toc|

»To add a drop shadow, click the object,
and then drag from the first object to
where you want to place the shadow.

%

Drop shadow applied fo an object

Drop shadow applied fo text
+ To change the perspective of the drop

shadow, drag the start handle.

+To change the direction of the drep
shadow, drag the end handle.

« To adjust the opacity of the drop shadow,
move the slider.

+To change the color of the drop shadow,
drag a coler from the color palette to the
end handle.

You can also adjust drop shadows by using
the controls on the property bar.

ﬂCore\DRAWXB(M—B\t]—D:\BookofTheCoreI Draw X8 -2016,\safi corel menu\Backup_of_Backup_of_ddddfff.cdr @I" - [ X
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help
FH-@ & FE8k 5 B UMy [w <[ M 8 swnr o -
Pl | + e (L@ (L Ee (L] BB L 4k [L - vy < By
¥|-92.679" W 8702 1000 |% £]-92.678" —|0.0 e . 3
0 x L33
. i :139.548 " HEETY 0o (% © OB D[30548" I 00 I
Q“ ﬁWeIcomeScleen Untitled-1 Backup_of_Backup_of_... Hints
7
Update text - To access newer features, text must be updated. Update o X HINTS Leam Ahl
more =
- 88 86 84 82 80 7 3
i i 1 o

saipadolg 3algo ﬁ@

Jmbeueyy 3aalgg 7

Drop Shadow

| Contour |

Blend
U Distort
E} Envelope

@ Extrude

]
D

oo N B

Ea

oz
.

Before

After

ﬂ CorelDRAW X8 (64-Bit) - D:\Book of The Corel Draw X8 -2016,\safi corel menu\Backup_of_Backup_of cccnn.cdr @I" - B X
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help
FE-G 4 F &k <A G A EE - = B snapTo > 43 [~
X:|-90.768 " W 16,082 " | = .
P, |4+ — B Yime Tose | SIS T B, =, &[HE] o] 5
:| -90.768 " W 16,002 " 1000 |% £9/-90.768 " 0.0 o » 3
k 0 X o
“ 37.356" I13.749" 1000 % ° Oloa /37356 " I |00 e 2
Q‘A ﬁ Welcome Screen Untitled-1 Backup_of_Backup_of_Backup_of_cccnn.cdr Backup_of_Backup_of_... Hints
?
- ‘ Updat L X
J‘:'r‘ Update text To access newer features, text must be updated pdate (7] X HINTS ::;: S :
Qlf__® . % L P '.3 % 74 7 2
| ¥ ~ Contouring ohjects
i, o
g
fb - +To contour an object, click the object, and &
= 2
then drag the start handle towards its jad
D‘ center (to create an inside contour) or .g
O away from it {to create an outside ;,_
=1 contour). a
D‘ Multlple Object Has Been +To adjust the number of steps and the T
H d f offset in th tour, th =
Created By Using Contour Tool SrreeeteTReL e conten mete e =
A w : =
2
Ve =
2 3
Ll = g




Vinod Computer Institute Mehnagar Azamgarh UP.

Blend Tool. The blend tool lets you blend two objects. To blend two objects, drag from
the first object to the second object, holding down alt if you want to draw a freehand path for
the blend. The first object is the start object of the blend, and the second object is the end
object. The cursor changes when it is over an object that can be used in a blend. To use the
slider to adjust individually the distance and color progression for the blend, double-click the
handles on the slider, and then move the handles. You can also adjust blends by using the
controls on the property bar.
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% Blend tool
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blend, and the second object is the end

@ Distort Tool. The distort tool lets you apply a push or pull distortion, a zipper distortion,
or a twister distortion to an object.

@ Push And Pull Distortion Tool. To apply a push effect, click the push and pull distortion
button on the property bar, and then drag the mouse until you are satisfied with the amount of
push distortion.

@ Zipper Distortion Tool. To apply a zipper effect, click the zipper distortion button on the
property bar, and then drag the mouse to determine the amplitude of the zipper effect.

Twister Distortion Tool. To apply a twister effect, click the twister distortion button

on the property bar, and then drag the mouse in circles around the object. The closer you are
to the object’s border, the more dramatic the effect is. If you drag from the center of the object,
the twister effect is more subtle. To change the center of distortion, drag the diamond-shaped
position handle to a new location. To adjust the number of points on a zipper distortion, move
the slider. You can also adjust distortions by using the controls on the property bar.

29|Page




Vinod Computer Institute Mehnagar Azamgarh UP.

ﬂ CorelDRAW X8 (64-Bit) - D:\Book of The Corel Draw X8 -2016,\safi corel menulccenn.cdr |;|J - [ X
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help
FE-d4 F.BE8R 5~ B[] O] e D BE Y sapTo v 3 B~
e -+ — O uR|® 00 O T[T e o
X:|-90.188" w1 10,199 " 1000 |% £2]-90.188 " | =00 o . 3
k 0¥ = sl -
. ¥: 4361 $3.009" 000 % ° Qo0 4361 Ll & I oo ° !
Q“ ﬁ Welcome Screen Untitled-1 Backup_of_Backup_of_eebn.cdr Backup_of_eebn.cdr Backup_of_ccenn.cdr ccenn.cdr Hints
?
Jq_ Update text - To access newer features, text must be updated. Update (7] X HINTS Leam Py 13
Fl . — — — — . — - more %
Q L M o . D S SR S, u o R o L nepe =4
“ ~  Applying distortion effects
T, = mnismn too %
{b *To apply a Push effect, click the Push and ‘Tz—
- " . =
| pull distortion bution CSJ on the jas
D‘ property bar, and then drag the mouse =
o
O - until you are satisfied with the amount of =3
T = o
“ i ! Push distortion, =
Q, ( =f=
(=]
A ] a3 =
2% . . § This Rectangle Has Been =
i . . . o
\“ 3 Distort By Using Distort Tool E
]
@ @ Drop Shadow
= To apply a Pull effect, click the Push and
E Contour pull distortion button @ on the
% Blend property bar, and then drag the mouse to
) the left until you are satisfied with the
Q‘ F{ Envelope amaount of Pull distortion.
@ Extrude = To apply a Zipper effect, click the Zipper
g | distortion button {:} on the property

Envelop Tool. The envelope tool lets you shape an object by dragging the nodes of the
envelope. To apply an envelope to a selected object, choose one of the following modes from
the property bar, and then click the object. Straight line mode creates envelopes based on
straight lines, adding perspective to objects. Single-arc mode creates envelopes with an arc
shape on one side, giving objects a concave or convex appearance. Double-arc mode creates
envelopes with an s shape on one or more sides. Unconstrained mode creates freeform
envelopes, which let you change the properties of the nodes, and add and delete the nodes.
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Extrude Tool. The extrude tool lets you apply the illusion of depth to objects. To create
an extrusion, drag the object in the direction in which you want to project the three-
dimensional extrusion. To adjust the depth of the extrusion, move the slider. To rotate an
extrusion, double-click it to display its rotation handles, and then drag any rotation handle.
You can also adjust extrusions by using the controls on the property bar.
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Transparency Tool. The transparency tool lets you apply transparencies to objects. To
apply a transparency to an object, select the object with the transparency tool, and then drag
across the object. The appearance of the transparency varies depending on where you first
click, the direction in which you drag, and the distance that you drag. To change the intensity
of the transparency, drag a color from the color palette to the end handle. The lighter the color,
the more opaque the resulting transparency. The basic “Fade out” transparency is
the linear one. This is the default preset of the tool and is applied by clicking and dragging on
the selected object with CorelDraw’s transparency tool activated.
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Color Eyedropper Tool. The color eyedropper tool lets you select and copy a color from
an object on the drawing window or the desktop. To sample a color from an object, click the
color eyedropper tool from the toolbox, and click select from desktop on the property bar if
required. To fill an object with a sampled color, wait for the color eyedropper tool to switch to
apply color mode, then hover over an object until a solid color swatch appears, and click to
apply the color.
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Attributes Evedropper Tool. The attributes eyedropper tool lets you select and copy
object properties, such as line thickness, size and effects, from an object on the drawing
window. To start sampling object attributes, such as outline and fill, transformations, and
effects, click the attributes eyedropper tool from the toolbox. To apply the object attributes to
another object, wait for the attributes eyedropper mode to switch to the apply object attributes
mode, and click to apply the object attributes.

Interactive Fill Tool (G). The interactive fill tool lets you apply various fills. To apply
an interactive fill to an object, click the object, and then drag. To change the start or end color
of a fountain fill, drag a color from the color palette to the start or end node. You can also
adjust fountain fills by using the controls on the property bar. You can also use the property
bar to apply other fills that you can adjust interactively, such as pattern fills and texture fills.
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Mesh Fill Tool (M). The mesh fill tool lets you apply a mesh grid to an object. To add
rows or columns to the mesh grid, type values in the grid size boxes on the property bar or
double-click in the object. To change the color of a grid, drag a color from the color palette to

the grid. To adjust the nodes in the grid, click the shape tool in the toolbox and drag nodes
across the object.
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Smart Fill Tool. The smart fill tool lets you create objects from enclosed areas and then
apply a fill to those objects. To fill an area where objects overlap, choose your settings from
the property bar, and then click the area.
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Outline Pen Tool (F12). The Outline tool opens a flyout that gives you quick access to
items such as the Outline pen dialog box and Outline color dialog box. For the work | do, |
really need the CMYK defaults. Workaround is the Colour Docker which | use as well but the
Outline Pen Colour in CMYK would be nice if it worked as well.
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Outline Color Tool (Shift+F12). This option used to set the outline color of the objects
from the dialog box after clicking the tool. You can quickly add 10% tint of a color to a
selected object. If you want to change the fill color, hold down Ctrl, and click a color swatch
on the RGB or CMYK color palette. If you want to change the outline color, hold down Citrl,
and right-click a color swatch on the RGB or CMYK color palette.

No Outline Tool. This option used to do not display outline in your objects.

Hairline Outline Tool. This option used to do display outline in your objects.

Edit Fill Tool. The Fill tool opens a flyout that gives you quick access to items such as
the fill dialog boxes.

No Fill Tool. This option used to remove the fill color in your objects.

[ Uniform Fill Tool. This option used to apply a solid fill color in your objects.
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|Z| Fountain Fill Tool. (F11). This option used to fill two or more color in your object. And
change color style linear, redial, conical, squire.
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Vector Pattern Fill. This option used to a apply vector pattern fill, full color, and Bitmap
color pattern in your object.
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Bitmap Pattern Fill. This option used to apply a bitmap pattern fill in your objects.

EI Two Color Pattern Fill. This option used to apply a two color pattern fill in your objects.

Texture Fill. Apply a preset texture fill to create the illusion of a variety of textures such
as water, clouds and stone.

CorelDRAW X8 (64-Bit) - D:\Book of The Corel Draw X8 -2016,\safi corel menu\Texture fi.cdr - B X
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help
FH-@8& F i By mx [- W B[ sen- & B-

X:|-146.306 " 19,302 " 1000 |% ; o oy |00 v -1 [f00" =alTe = =
§E§ V. 69.287 " 1 [14.395" 1000 (% & )00 o L E G a a ann Al & Rinas =N rﬁ @ 0.5 pt v (ha %y <

Edit Fill
X:|-146.306 " 19,302 ¢ 1000 |% o $|-146.306"

k‘ & Y:|69.287 " $14395" 1000 |% ° Oloo

Do XE AdBESDEB

Q" A Welcome Screen  Untitled-1  Texture fi.cdr
W] Aerial clouds:

4, Updatetext - To access newer features, text must be updated. ~
T, = Texture : | 2,010 | & Shade: [ |~ [a
Q. Softness % |25 alr Ughe: | N ~ | &
t,.,‘ Density %: |0 =N Brightness +%: 0 =i
N« Eastern light: | -55 =B
@) - Northern light: | -14 e
@) 4 - Volume %: |83 BN
)
A : Randomize

\
f‘ B Transformations... Options... Fill winding Cancel
'\i, - - - o

» To nudge the object, press the Arrow keys.
l;‘-" » To scale the object, drag one of the corner
E sizing handles, holding down Shift if you
—; want to scale from the center.

/Z <8 =

4 : X s

| Texture Fill Applied To The Object |
Q>
Lo
=
= L] x

=
i

PostScript Fill. Apply an intricate postscript texture fill in your objects.
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Color Tool. This option used to fill inside color in your object. Apply color to outline
from the color Dockers that appear after clicking this tools.
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Chapter-3. File Menu. (Alt+F).
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New (Ctrl+N). This command is used to create a new blank document. You can also use this
command to create a new your drawing.
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New From Template. This command is used to open an existing document and change
according to your link file.

Open (Ctrl+0). This command is used to open specific save file, from hard disk, pan drive,
and various document only. CDR. Etc.
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Open Recent. This command is used to open recently 10 files. If you quit CorelDraw with
documents still open (and have this option checked), CorelDraw automatically reopens those
documents the next time you start the program.

Close (Ctrl+W). This command is used to close currently open CorelDraw document.

Close All. This option is used to close all currently open CorelDraw document. If you have
unsaved changes in any of them, CorelDraw gives you the opportunity to save them.

Save (Ctrl+S). This command is used to save the current document and CorelDraw to your
hard drive. If you’ve already saved the document, choosing this command overwrites the
previous version. If you haven't saved the document before, choosing this command opens
the save as dialog box.

Save As (Ctrl+Shift+S). This command is used to change file name and location saves the
current document your hard drive. In other words, only the save as copy has the most recent
changes you made to the original file. In order to export CorelDraw image to jpg, launch
the CoreIDRAW. Open a file you want to convert from quick start menu. Go to the "File"
menu and click on the "Export for Web" option. In the following window, select the "JPEG"
format and press the "Save As" button.
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Save As Template. Use this option to save the open document as a template. A template is
a reusable document that contains editable regions. CorelDraw automatically saves all
template documents in a templates folder in the selected site’s folder.
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Revert. This command is used to restore recent last time save file. Your last saved work.

Acquire Image. You can scan images in CorelDraw. CorelDraw supports scanners that use
Microsoft windows image acquisition (WIA), which provides a standard interface for
scanning images. If your scanner does not support WIA, but has a compatible twain driver,
you may be able to use this driver for scanning images in CorelDraw. Twain is supported by
both the 32-bit and 64-bit versions of CorelDraw. However, note that there are very few 64-
bit twain drivers available.

Select TWAIN Source. For a scanner that uses a TWAIN driver.

Select WIA Source. For a scanner that uses a WIA driver.

Acquire. Preview the image, and select the area that you want to scan. WIA, in combination
with some scanners, supports scanning of multiple areas to separate files. Click scan. To scan
additional images during the same session, click file »acquire image »acquire.
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Search Content. By default, your search results include all relevant content such as vector
graphics, bitmaps, and fonts. You can narrow down the search results by excluding content.
For example, if you are searching for graphics, you can display only vector graphics or only
bitmaps. If you want to choose a font for your project, you can display only fonts. Click file
»search content to open the get more Docker, and click connect. Libraries lets you browse
online and local content. Favorite folders lets you browse your favorite locations. Folders lets
you browse the folder structure available on your computer.

Import (Ctrl+l). You can import files created in other applications. For example, you can
import an Adobe Portable Document Format (PDF), JPEG, or Adobe Illustrator (Al) file. You
can import a file and place it in the active application window as an object. You can also
resize and center a file as you import it. The imported file becomes part of the active file. You
can also import a bitmap as an externally linked image. When you import a linked bitmap,
edits to the original (external) file are automatically updated in the imported file. Click File »
Import. Choose the folder where the file is stored. Choose a file format from the list box next
to the File name box. Press Enter to center the file on the drawing page.
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Export (Ctrl+E). You can use the File » Export command to export files to a variety of bitmap
and vector file formats that can be used in other applications. For example, you can export a
file to the Adobe Illustrator (Al) or JPG format. You can also export a file so that it is
optimized for use with a suite of office productivity applications, such as Microsoft Office or
Corel WordPerfect Office.
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Export for Office. Let you set options to meet the output requirements of Microsoft office
applications. WordPerfect office - optimizes the image for Corel WordPerfect office by
converting it to a WordPerfect graphics file (WPG). Compatibility- lets you save the drawing as
a portable network graphic (PNG) bitmap. This preserves the appearance of the drawing when
you import it into an office application. Editing- lets you save the drawing in the extended
metafile format (EMF). This retains most of the editable elements in vector drawings.
Presentation - lets you optimize the file for outputs such as slide shows or online documents (96
dpi). Desktop printing- lets you maintain good image quality for desktop printing (150 dpi).
Commercial printing - lets you optimize the file for high-quality printing (300 dpi).

Export HTML. When publishing a document or selection to the World Wide Web, you can
choose several options, such as image format, html layout, export range, and file transfer
protocol (ftp) site parameters. CorelDraw assigns the extension .HTML to documents you
publish in the html format. By default, html files share the same name as the CorelDraw (CDR)
source file and are saved in the last folder you used to store exported web documents.

Send To. This command is used to send e-mail.

Publish To PDF. You can export a document as a pdf file. A pdf file can be viewed, shared,
and printed on any platform provided that users have adobe acrobat, adobe reader, or a pdf-
compatible reader installed on their computers. A pdf file can also be uploaded to an intranet or
the web. You can also export an individual selection or an entire document to a pdf file. To
select a compatibility option. Click file »publish to pdf. Locate the folder in which you want to
save the file. Type a filename in the file name box.
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Print (Ctrl+P). Using CorelDraw, you can print one or more copies of the same drawing. You
can also specify the page type and the page range that you want to print. Before printing a
drawing, you can specify printer properties, including paper size and device options. For
example, you can specify printer features such as duplexing stapling. To set printer properties.
Click file »print. Click the general tab. In the destination area, choose a printer from the printer
list box. Click preferences. Set any properties in the dialog box.
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Print _General. After opening the file, go to file->Printor press Ctrl + Pand from
the Printer dropdown list select nova PDF. After setting up any additional options click
on Print and choose where you want to save the PDF file.

Destination. In the Destination area, choose a printer from the Printer list box.

Page. In the Destination area, choose a printer from the Printer list box. In the Destination
area, choose a page size and orientation option from the Page list box.

Copies Page. In the copies area, type a value in the number of copies box. If you want the
copies collated, enable the collate check box.

Print Range. In the Print range area, enable one of the following options. Current document,
prints the active drawing, Current page, prints the active page, Pages, prints the pages that
you specify, Documents, prints the documents that you specify, Selection, prints the objects
that you have selected, If you enable the Pages option, you can choose to print a range of
pages, only even pages, only odd pages, or both even and odd pages.

Print Merge. CorelDraw lets you combine text from a data source with a drawing. When you
merge documents, you can produce several different copies of a drawing. You can use merged
documents to create personalized documents, such as mailing lists, questionnaires, and
targeted marketing documents, where each printed document contains specific information
from a record in a data source, such as a text file or an ODBC data source (a Microsoft Excel
or Microsoft Access file). When you merge documents, you create a form document in
CorelDraw and combine it with a data source. A form document provides the pattern and
layout for a merged document. A data source supplies information for a drawing during the
merge. CorelDraw supports the following data source files: Text (TXT) files, comma-
separated values (CSV) files, Rich Text Format (RTF) files, and files that can be opened by
means of an ODBC data source.

Print Preview. You can preview your work to show how the position and size of the print job
will appear on paper. For a detailed view, you can zoom in on an area. You can view how the
individual color separations will appear when printed. Before printing your work, you can view
a summary of issues for a print job to find potential printing problems. For example, you can
check the current print job for print errors, possible print problems, and suggestions for resolving
issues. Click File »Print preview. To close the print preview, click File »Close print preview.

Document Properties. At the top of this window, except view the properties you can of change
some of them: title, subject, author, copyright, keywords, descriptions and rating. Below you
can see a block of properties that should not be changed. Here you will find the summary
statistics of all the properties of the document.
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Exit (Alt+F4). This command is allowing exit from CorelDraw application X7.
Chapter-4. Edit Menu. (Alt+E).
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E\\e View Layout Object Effects Bitmaps Text Table Tools Window Help

Undo (Ctrl+Z). This command is used to reverse the last action. To take backward in your
current work which you have done. Or you can choose this command repeatedly to step
progressively backwards through your changes, even after you save the document.

Redo (Ctrl+Shift+Z). Restores whatever changes you just made by using the undo command.
Selecting redo multiple times moves you progressively forward through changes you undid.
If you just used a command other than undo, repeat appears instead of redo. This property lets
you repeat the last action. For example, if you just pressed delete, the repeat command presses
it again.

Repeat (Ctrl+R). This option is used to repeat duplicate same objects. By using this option,
we can repeat our work again another object. You can undo the actions that you performin a
drawing, starting with the most recent action. If you don’t like the result of undoing an
action, you can redo it. Reverting to the last saved version of a drawing also lets you remove
one or more actions. Certain actions applied to objects, such as stretching, filling, moving,
and rotating, can be repeated to create a stronger visual effect.
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Undo Manager. Click edit »undo manager. In the undo manager docker, click the action that
precedes all the actions that you want to undo, or click the last undone action that you want
to redo. When you undo a series of actions in the undo manager docker, all actions listed
below the action that you click are undone. When you redo a series of actions in the undo
manager docker, the action that you click and all preceding undone actions are redone.

Cut (Ctrl+X). This command is used to deletes the selected text or objects from a document,
and copies them to the invisible windows or Macintosh clipboard so you can paste them
elsewhere. (The clipboard holds only one selection at a time.). Remove the selection and put
it on clipboard so you can paste it somewhere else. You can cut or copy an object to place it
on the Clipboard and paste it into a drawing or another application. Cutting an object places
it on the Clipboard and removes it from the drawing. Copying an object places it on the
Clipboard but keeps the original in the drawing.

Copy (Ctrl+C). This command is used to copies the selected item to your computer's memory
and available in clipboard use for later. Put a copy of the selection on the clipboard so you
can paste it somewhere else. You can create multiple copies of objects simultaneously, while
specifying their position, without using the Clipboard. For example, you can distribute object
copies horizontally, to the left or right of the original object; or you can distribute copies of
objects vertically, below or above the original object. You can specify the spacing between
copies of objects, or you can specify the offset at which copies of objects are created in relation
to each other.
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Paste (Ctrl+V). This command is used to places objects you’ve copied to your computer's
memory into the current document. Places the most recent selection from the clipboard into

your document at the insertion point. Add content on the clipboard your document.
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Paste Special. This command is used to choose how you wish to paste the clipboard item into
your document. Options range from text only for just plain text to increasingly more elaborate
options, which force CorelDraw to attempt to preserve various levels of formatting, such as
styles, bold, italic, bulleted lists, and so on.

Delete (Delete). This option is used to delete selected objects and text matters.

Duplicate (Ctrl+D). Duplicating an object places a copy directly in the drawing window and
does not use the Clipboard. Duplicating is faster than copying and pasting. Also, when
duplicating an object, you can specify the distance between the duplicate and the original
object along the x and y axes. This distance is known as the offset. You can apply a
transformation, such as rotating, sizing, or skewing, to the duplicate of an object while keeping
the original object intact. If you decide that you want to keep the original object, you can delete
the duplicate.
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Clone. When you clone an object, you create a copy of an object that is linked to the original.
Any changes you make to the original object are reflected automatically in the clone. Changes
you make to the clone are not automatically reflected in the original, however. You can remove
changes made to the clone by reverting to the original. Cloning lets you modify multiple copies
of an object simultaneously by changing the master object. This type of modification is
especially useful if you want the clone and master objects to differ by certain properties, such
as fill and outline color, but want the master object to control other properties, such as shape.
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Copy Properties. CorelDraw lets you copy attributes from one object to another. You can
copy object properties such as outline, fill, and text properties. You can copy object
transformations such as sizing, rotating, and positioning. You can also copy effects applied to
an object. Click the Properties flyout on the property bar, and enable any of the following
check boxes. Outline, Fill, Text.
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Step and Repeat (Ctrl+Shift+D). In the step and repeat docker, type a value in the number
of copies box, and click apply. In the vertical settings area, choose no offset from the mode
list box. In the horizontal settings area, choose spacing between objects from the mode list
box. To specify the spacing between object copies, type a value in the distance box. To place
the object copies to the right or left of the original, choose right or left from the direction list
box. In the horizontal settings area, choose no offset from the mode list box. In the vertical
settings area, choose spacing between objects from the mode list box. To specify the spacing
between copies of objects, type a value in the distance box. To place the copies above or below
the original, choose up or down from the direction list box

Select All. (Ctrl+A). Before you can change an object, you must select it. You can select
visible objects, objects that are hidden from view by other objects, and a single object in a
group or a nested group. In addition, you can select objects in the order in which they were
created, select all objects at once, and deselect objects. CorelDraw lets you select text to edit
specific characters or modify it as an object. For example, you can select specific characters
to change the font or select a text object, such as a text frame, so you can move, resize, or
rotate it.
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Find. (Ctrl+F). Using search criteria that you specify, the Find wizard guides you step-by-
step when you need to find and select objects in a drawing. The search criteria can include
object type and its related properties, fill and outline properties, vector effects applied to
objects, or the name of an object or style. For example, you can search for and select all
rectangles with rounded corners and without fill, or all text on a path. You can also search for
objects that contain the same properties as a selected object.

Replace. (Ctrl+H). The Replace wizard guides you through the process of finding objects that
contain the properties you specify and then replacing those properties with others. For
example, you can replace all object fills of a certain color with fills of a different color. You
can also replace color models and palettes, outline properties, and text attributes, such as font
and font size.
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Chapter-5. View Menu. (Alt+V).

ﬂCDre\DRAWXB(M-E\t]-Unt\t\ad-ﬂ IL - X
Eile Edit | View | Layout Object Effects Bitmaps Text Table Tpols Window Help

Simple Wireframe. Simple wireframe displays an outline of the drawing by hiding fills,
extrusions, contours, drop shadows, and intermediate blend shapes; also displays the bitmaps
in monochrome. This mode lets you quickly preview basic elements in a drawing.
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Wireframe. Wireframe displays a drawing in simple wireframe mode plus intermediate blend
shapes.

Draft View. Draft displays fills and bitmaps with a low resolution. This mode eliminates some
detail to allow you to focus on the color balances in a drawing.
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Normal. Normal displays a drawing without PostScript fills or high-resolution bitmaps. This
mode refreshes and opens slightly faster than the Enhanced mode.
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Enhanced. Enhanced displays a drawing with PostScript fills, high-resolution bitmaps, and
anti-aliased vector graphics.
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Pixels. Pixels displays a pixel-based rendition of the drawing, which allows you to zoom in
on an area of an object, and then position and size the object more precisely. This view also
lets you see what the drawing will look like when it is exported to a bitmap file format.

Simulate Overprints. Simulate overprints simulates the color of areas where overlapping
objects were set to overprint and displays PostScript fills, high-resolution bitmaps, and anti-
aliased vector graphics. For information about overprinting objects, see to.

Rasterize Complex Effects. Rasterize complex effects rasterizes the display of complex
effects, such as transparencies, bevels, and drop shadows when in Enhanced view. This option
Is useful for previewing how the complex effects will be printed. To ensure the successful
printing of complex effects, most printers require complex effects to be rasterized.

Proof Colors. When you turn soft proofing on, colors in the document window, color palettes,
and preview windows of dialog boxes appear different. Simulating printer output may cause
on-screen colors to appear dull because all colors are brought into a CMYK color space, which
has a smaller gamut than an RGB color space.

Full Screen Preview (F9). This command is used to shows our work in full screen mode.

This Design Has Been Display
Full Screen Preview

‘\\

<

Rulers. You can display rulers in the drawing window to help you draw, size, and align objects
precisely. You can hide the rulers or move them to another position in the drawing window.
You can also customize the ruler settings to suit your needs. For example, you can set the ruler
origin, choose a unit of measure, and specify how many marks or ticks appear within each full
unit mark.

Preview Selected Only. You can preview a drawing to see how it will look when printed or
exported. When you preview a drawing, only the objects on the drawing page and in the
Immediate area of the drawing window are displayed, and you can see all layers that are set to
print in the Object manager docker. If you want a closer look at specific objects in a drawing,
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you can select and preview them. When you preview selected objects, the rest of the drawing
is hidden.

Page Sorter View. If a document contains multiple pages, you can view them all at once by
using the Page Sorter view. You can also display consecutive left-hand and right-hand pages
on the screen at the same time (facing pages) and create objects that span two pages.
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View Manager (Ctrl+F2). You can preview a drawing to see how it will look when printed
or exported. When you preview a drawing, only the objects on the drawing page and in the
immediate area of the drawing window are displayed, and you can see all layers that are set to
print in the view manager docker. If you want a closer look at specific objects in a drawing,
you can select and preview them. When you preview selected objects, the rest of the drawing
is hidden.
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Printable Area. You can display the printable area of a drawing by clicking View »Page »
Printable area. The printable area is usually indicated by two dotted lines inside or around the
page, depending on the current printer settings. One outline indicates the area that can be
printed on the current printer; the other outline indicates the paper size that your printer is set
to use.

Baseline Grid. You can align text within a frame or in different frames by using the baseline
grid. This is useful, for example, when you want to align two or more text frames that contain
different fonts, font sizes, and spacing. All objects can snap to the baseline grid; only text
frames can align to the baseline grid. Snapping is turned on or off for all objects (it’s a grid
setting). Alignment is turned on or off for individual frames (it’s a text frame setting). For
information about displaying or hiding the baseline grid, turning snapping on or off, changing
the grid color, and setting the line spacing, see Setting up the baseline grid.

Gridlines. A horizontal, vertical, or slanted line that can be placed anywhere in the drawing
window to aid in object placement. You can add a guideline wherever you need one; however,
you can also choose to add preset guidelines. There are two types of preset guidelines Corel
presets and user-defined presets. Examples of Corel presets include guidelines that appear at
1-inch margins and guidelines that appear at newsletter column borders. User-defined presets
are guidelines whose location you specify. For example, you can add preset guidelines that
display margins at a distance you specify or that define a column layout or grid. You can
remove guidelines at any time.

Alignment Guides (Alt+Shift+A). You can align objects interactively on the drawing page
by using alignment guides. Alignment guides are temporary guidelines that appear when you
create, resize, or move objects in relation to other nearby objects. While dynamic guides
provide precise measurements for creating technical illustrations, alignment guides are useful
in page layout to align text or graphic elements quickly and accurately.

Dynamic_Guides (Alt+Shift+D). You can display dynamic guides to help you precisely
move, align, and draw objects in relation to other objects. Dynamic guides are temporary
guidelines that you can pull from the following snap points in objects — center, node,
quadrant, and text baseline. For more information about snap points and snapping modes, see
Snapping objects.

Snap To Object (Alt+Z). When you move or draw an object, you can snap it to another object
in a drawing. You can snap an object to various snap points on the target object. When you
move the pointer close to a snap point, the snap point becomes highlighted, which identifies it
as the pointer’s snapping target. To snap an object to another object with greater precision,
you can first snap the pointer to a snap point in the object, and then snap the object to a snap
point in the target object. For example, you can snap the pointer to the center of a rectangle,
drag the rectangle by the center, and then snap the rectangle to the center of another rectangle.

57|Page


javascript:WWHClickedPopup('CorelDRAW',%20'CorelDRAW-Glossary.html#1835369', 'popups/u002Fglossary_drptdes-1835369.html');
file:///C:/Program%20Files/Corel/CorelDRAW%20Graphics%20Suite%20X8/Languages/EN/Help/Draw/CorelDRAW-Setting-up-baseline-grid.html%231244219
javascript:WWHClickedPopup('CorelDRAW',%20'CorelDRAW-Glossary.html#1839782', 'popups/u002Fglossary_drptdes-1839782.html');
file:///C:/Program%20Files/Corel/CorelDRAW%20Graphics%20Suite%20X8/Languages/EN/Help/Draw/CorelDRAW-Snapping-objects.html%231315159

Vinod Computer Institute Mehnagar Azamgarh UP.

Chapter-6. Layout Menu. (Alt+L).
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Insert Page. In the pages area, type the number of pages you want to add in the number of
pages box. To place the new page before or after the current page, enable one of the following
options. Before, after, if you want to insert a page before or after a page other than the current
page, type the page number in the existing page box. You can also insert a page before or after
the current page by clicking one of the add page buttons in the document navigator. You can
also add a page by right-clicking a page tab in the document navigator and clicking insert page
after or insert page before.

CorelDRAW 64-Bit) - EAPROJECT\PROJECT\COREL DRAW\safi\LAY'S.cd - B X
Eile Edit View Object Effects Bitmaps Text Table Tools Window Help
PDF or ‘o [ 2 | i@

" b T
dBE-dd &5 O~ B [ [ & [esx v m Ao B -0 snepIo~ 8 [~
1200 via o . ,, =] | Bfo.25" s
Custom - Dles" s D (] Qh []n{] Units: | inches v O 01 = Q‘: 025" e E(.
100" 00" 100.0 = 100" 0.0

o 425" 100.0 425" 0.0 ;
Q‘. A Welcome Screen Untitled-1 LAY'S.cdr

+-'r Update text - To access newer features, text must be updated.
Pl

48

| Insert Page X

+
e Pages
L - Number of pages: |2 ‘:
) T

Place: Before
O‘ = ® After
O‘ Existing Page: |1
A‘ =5 Page size
2,
kel
o,
2.
7.
A ™
>
=
g1~
==
S -

> &

&l om0 v:0k:100 Hairline
2oz

Duplicate Page. In the insert new page area of the duplicate page dialog box, choose one of
the following options. Before selected page, after selected page, copy layers only — lets you
duplicate the layer structure without copying the contents of the layers. Copy layer(s) and their
contents — lets you duplicate the layers and all their contents. You can also duplicate a page
by right-clicking a page name and choosing duplicate page.
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Delete Page. In the delete page dialog box, type the number of the page that you want to delete.
You can delete a range of pages by enabling the through to page check box and typing the
number of the last page to delete in the through to page box.
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Go To Page. CorelDraw allows you to move the insertion point to any page in your document
by using the Go to command. To take advantage of this feature, follow these steps: Choose
the Go To option from the Layout menu.
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Insert Page Number. You can insert page numbers on the current page, all pages, all odd
pages, or all even pages. When you insert page numbers on multiple pages, a new master layer
Is automatically created, and the page number is placed on it. The master layer can be an all-
page master layer, an odd-page master layer, or an even-page master layer. For more
information about master layers, see creating layers.

On Active Layer.On active layer — lets you insert a page number on the layer that is currently
selected in the Object manager docker. If the active layer is a master layer, page numbers are
inserted on all pages of the document where the master layer is visible. If the active layer is a
local layer, the page number is inserted on the current page only.

On All Pages. On all pages — lets you insert page numbers on all pages. The page number is
inserted on a new all-page master layer.

On All Odd Pages. On all odd pages — lets you insert page numbers on all odd pages. The
page number is inserted on a new odd-page master layer.

On All Even Pages. On all even pages — lets you insert page numbers on all even pages. The
page number is inserted on a new Even -page master layer. By default, the page number is
centered at the bottom of the page.

Switch Page Orientation. The orientation of the page can be landscape or portrait. In
landscape orientation, the drawing’s width is greater than its height, and in portrait orientation,
the drawing’s height is greater than its width. Any pages you add to a drawing have the current
orientation; however, you can change the orientation of individual pages at any time.

Page Setup. You can begin working on a drawing by specifying settings for the size,
orientation, and layout style of the page. The options you choose when specifying the page
layout can be used as a default for all new drawings you create. You can also adjust the page
size and orientation settings to match the standard paper settings for printing. There are two
options for specifying a page size: choosing a preset page size and creating your own. You can
choose from many preset page sizes, ranging from legal-size paper and envelopes to posters
and webpages. If a preset page size does not meet your needs, you can create a custom page
size by specifying a drawing’s dimensions

Page Background Solid. You can choose the color and type of background for a drawing. For
example, you can use a solid color if you want a uniform background. If you want a more
intricate or dynamic background, you can use a bitmap. When you choose a bitmap as the
background, it is embedded in the drawing by default. This option is recommended. However,
you can also link the bitmap to the drawing so that if you later edit the source image, the change
is automatically reflected in the drawing. If you send a drawing with a linked image to someone
else, you must also send the linked image.
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Page Background Bitmap. When you export files to a bitmap format, the background color
Is used for anti-aliasing edges. If the bitmaps are of irregular shape and will be placed against
a background different from white, it is recommended that you select a matching page
background color. For example, if you are planning to place the exported bitmap against a blue
background, you may want to choose a similar blue color for the page background.
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Page Layouts. When you use the default layout style (full page), each page in a document is
considered a single page and prints on one sheet. You can choose layout styles for multipage

publications, such as booklets and brochures. The multipage layout styles — book, booklet,
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tent card, side-fold card, top-fold card, and tri-fold brochure — split the page size into two or
more equal parts. Each part is considered a separate page. The advantage of working with
separate parts is that you can edit each page in upright orientation, and in sequential order in
the drawing window, regardless of the layout required to print your document. When you are
ready to print, the application automatically arranges the pages in the order required for
printing and binding.

Chapter-7. Object. Menu (Alt+J).

LY CorelDRAW X8 (64-Bit) - Untitled-1 B - B X
File Edit View Layout Effects Bitmaps Text Table Tools Window Help

Insert Barcode. The Barcode wizard in CorelDraw lets you add bar codes to drawings. A bar
code is a group of bars, spaces, and sometimes numbers that is designed to be scanned and
read into computer memory. Bar codes are most commonly used to identify merchandise,
inventory, and documents. The Barcode wizard guides you through the process of inserting a
bar code. If you need additional information at any step, you can consult the Help in the
Barcode wizard.

Insert OR Code. CorelDraw lets you insert QR codes with embedded information such as a
web address, email address, phone number, text message, geo location, or plain text. After you
insert a QR code, you can edit and validate it. For more information, see Editing QR codes
and Validating QR codes.

Validate Barcode. After inserting and formatting a QR code, you can validate it to make sure
that it can be read by QR code readers and scanners. To insert, edit, and validate QR codes,
you must sign in to your account and be connected to the Internet.

Insert New Objects. To insert a linked object into the active drawing from another
application, click Object »Insert new object. In the Insert new object dialog box, enable the
Create from file option, browse to the file you want to insert, and enable the Link check box.
You can also create an embedded object by enabling the Create new option, and choosing the
application in which you want to create the object from the Object type list box. You can also
insert an embedded object by selecting an object in the source application, and dragging it to
the window of the target application.

Link. CorelDraw lets you insert CorelDraw files as linked or embedded objects in other
applications. You can also insert a linked or embedded object in CorelDraw. A linked object
remains connected to its source file; whereas an embedded object is not linked to its source
file but is integrated into the active document.

Symbol (New Symbol). Symbols are objects that are defined once and can be referenced many
times in a drawing. You can have multiple instances of a symbol in a drawing with little impact
on file size. Symbols make editing a drawing quicker and easier, as changes made to a symbol
are automatically inherited by all instances.
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Edit Symbol. You can edit a symbol; any changes you make affect all instances in the drawing.
The selection handles for symbols differ from those for objects. Selection handles for symbols
are blue; selection handles for objects are black. When you insert a symbol from an external
library, a copy of the symbol is added to the active drawing, but it remains linked to the source
symbol. You can edit a linked symbol or you can decide to break the link to the external library
and make the symbol internal. When the link is broken, the local copy of the symbol remains
in the drawing as an internal symbol, and it can be edited independently from the symbol in
the external library.

Break Link. If there are other instances of the symbol in the drawing, you are given the choice
to break the link to all instances. If you do, the internal symbol will then apply to all the
instances. You can also make a linked symbol internal by right-clicking a symbol and choosing
Break link.

Symbol Manager (Ctrl+F3). To edit a linked symbol, click File » Open. Choose the drive and
folder of the library that contains the symbol that you want to modify. Click a library (.csl)
filename, and click Open. The symbol appears in the Symbol manager docker, and it can be
selected and edited like any other symbol. You may need permission to change files on the
network. You can also convert an existing object or objects to a symbol by dragging the object
or objects to the Symbol manager docker. To open the docker, click Object » Symbol » Symbol
manager.

File Edit View Layout Effects Bitmaps Text Table Tools Window Help
FrE-d g Ry [l 1nsert Barcode... 23% ~ m (2B 2 snepIo~ 3 [F-
N —TRLA%5 w15 247 Insert OR Code
[ -478.426 mm j —
B N esazmm 3 23 @, Validate Barcode VE S Yy &
N & WelcomeScreen U o Insert New Object... Symbol Manager
4 O
«  Updatetext - Toace s Links. Update | @ X  Symbol Preview: 0
tv, ) - Symboll ¢
: w [ Sembal ¥R Mew symbol... | e e
B g
g . PowerClip » | ©5 Edit Symbeol.. =
W ocal E
Q Transformations . MRS 2
= Revert to Objects ® [ 2
+ Align and Distribute
. ord L
Order »
I Chsymbel.cdr
) [1] EwortLibrary.. b PLocal Symbols
®) J « SymbalManager  CtisF3 [ Network Symbols
4 Group v 7 L
o / o Name | Type De
a | P Hide » N\ e, I u
) . : 5T b 3
s Lock R .
AR TASY B\ N\
b "1 | §
7, K\ b $haging -Io--}-,E'idlt---Symbol---New Symbol.
= b ot \ J ™ This emmand Use|To Create Same Ne bol Library
4 7 TN [U3E/
e ' v N
o, - w Join Curves A | J
] — Overprint Fill J
O | ~. v
Overprint Outline L
2, -
@ " Object Hinting E &
< >
| Object Properties Alt+Enter v
& 1of 1 Object Manager < TR eF E| &
»_

Power Clip (Place Inside Frame). CorelDraw lets you place vector objects and bitmaps, such
as photos, inside other objects, or frames. A frame can be any object, for example artistic text
or a rectangle. When the object is larger than the frame, the object, called the contents, is
cropped to fit the form of the frame. This creates a Power Clip object.
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Extract PowerClip. The contents remains in the same location, but it is separated from the
frame. The PowerClip frame remains as an empty Power Clip frame. You must extract the
contents of each level in a nested PowerClip separately. You can also select the PowerClip
object and click the Extract contents button on the PowerClip toolbar.

Edit PowerClip. While you edit the contents, the frame appears in Wireframe mode and
cannot be selected or edited. You can also double-click the PowerClip object to enable it for
editing, or select the PowerClip object and click the Edit PowerClip button on the PowerClip
toolbar. When you have finished editing the contents, click the Stop editing contents button.
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Finish Editing This Level. You can also double-click the PowerClip object to enable it for
editing, or select the PowerClip object and click the Edit PowerClip button on the PowerClip
toolbar. When you have finished editing the contents, click the finish editing contents button.
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Create Empty PowerClip Frame. You can create an empty PowerClip frame from an object,
or convert a PowerClip frame back to an object. Creating empty PowerClip frames or text
frames is useful when you want to define the layout of your document before adding the
content. For more information about text frames, see Adding paragraph text. After you create
an empty PowerClip frame, you can add contents to it. You can also add contents to a
PowerClip frame that already contains another object.
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Lock Contents To PowerClip. You can also right-click a PowerClip object and click Lock
contents to PowerClip, or you can select the PowerClip object and click the Lock contents to
PowerClip button on the PowerClip toolbar.

Fit Contents Proportionally. Click Object »PowerClip »Fit contents proportionally. The
content is resized so that its longest dimension fits inside the frame. The content is not
distorted, and its aspect ratio is preserved. The whole content is visible, but there may be empty
areas in the frame.

Fill Frame Proportionally. Click Object » PowerClip »Fill frame proportionally. The content
is resized so that it fills the frame without being distorted. The content’s aspect ratio is

preserved. The frame is full, but there may be parts of the content that fall outside the frame
and are not visible.

Stretch Contents To Fill Frame. Click Object » PowerClip » Stretch contents to fill frame.
The content is resized and distorted so that it fills the frame. The content’s aspect ratio is not
preserved. The frame is full, and all of the content is visible.

Transformation (Position Alt+F7). The object origin, also known as "anchor point" or
"reference point," can be the center of an object or any one of the object’s selection handles.
The object origin remains stationary when an object is positioned by typing values in the x and
y boxes on the property bar. When you enable the Relative position check box on the
Transformation docker, the position of the center anchor point is identified as 0, 0 in the H and
V boxes. When you specify a different position in the H and V boxes, the values represent a
change from the current position as measured from the center anchor point of the object.
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Rotation. You can also view and set the relative center of an object by clicking the object to
display the rotation handles and dragging the relative center handle (circle with a dot in the
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middle) to a new position. You can set the relative center of an object to its original position
by enabling the Relative center check box in the Transformation docker and clicking the center
option in the area below the check box.
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Scale And Mirror. CorelDraw lets you size and scale objects. In both cases, you change the
dimensions of an object proportionally by preserving its aspect ratio. You can change the
dimensions of an object by specifying precise values or by changing the object interactively.
When you scale an object, you change its dimensions by a specified percentage. Mirroring an

object flips it from left to right or top to bottom. By default, the mirror anchor point is in the
center of the object.
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Size. CorelDraw lets you size and scale objects. In both cases, you change the dimensions of
an object proportionally by preserving its aspect ratio. You can change the dimensions of an
object by specifying precise values or by changing the object interactively. When you scale an
object, you change its dimensions by a specified percentage. The anchor point of an object,
also known as "object origin," remains stationary when you resize the object by typing values
in the Object size boxes on the property bar. If you want to change the object origin, click a
point on the Object origin button on the property bar.
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Skew. You can skew and stretch objects in CorelDraw. When you skew an object, you specify
the degree by which you want to slant the object. Stretching changes an object’s vertical and
horizontal dimensions none proportionally. Type values in the Skew angle boxes on the
property bar to specify the number of degrees by which you want to skew the object
horizontally or vertically. If you want to apply the scaling according to the object’s position
rather than the x and y coordinates, click the Relative to object button on the property bar.
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Clear Transformation. This command is used it will clear all types of transformation. If you
want to leave the original object unchanged and apply the transformation to copies that are
created, type a number in the Copies box in the Transformation docker. You can undo the
Clear transformations command by clicking Edit » Undo clear transformations.

Align and Distribute. CorelDraw lets you precisely align and distribute objects in a drawing.
You can align objects with each other and with parts of the drawing page, such as the center,
edges, and grid. When you align objects with objects, you can line them up by their centers or
by their edges. You can align multiple objects horizontally or vertically with the center of the
drawing page. Single or multiple objects can also be arranged along the edge of the page and
to the nearest point on a grid. You can also align objects with a reference point by specifying
its exact x and y coordinates.

Align Left (L). Align left — aligns text with the left side of the text frame or the bounding
box of artistic text. To align the left edges of objects.

Align Right (R). Align right — aligns text with the right side of the text frame or the bounding
box of artistic text. To align the right edges of objects.

Align Top (T). Align top — aligns text with the top side of the text frame or the bounding
box of artistic text. To align the top edges of objects.

Align Bottom (B). Align bottom — aligns text with the bottom side of the text frame or the
bounding box of artistic text. To align the bottom edges of objects.

Align Centers Horizontally (E). To align object centers along a vertical axis.

Align Centers Vertically (C). To align object centers along a horizontal axis.
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Centers To Page (P). Align an object with the page center. To align the center of the object
with the page center, make sure that the Align center horizontally button and Align center
vertically button in the Align area are enabled.

Order. You can change the stacking order of objects on a layer or a page by sending objects
to the front or back of other objects. You can also position objects precisely in the stacking
order, as well as reverse the stacking order of multiple objects.

To Front of Page (Ctrl+Home). Moves the selected object in front of all other objects on the
page.
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To Back of Page (Ctrl+End). Moves the selected object behind all other objects on the page.

To Front of Layer (Shift+PgUp). Moves the selected object in front of all other objects on
the active layer.

To Back of Layer (Shift+PgDn). Moves the selected object behind all other objects on the
active layer.

Forward One (Ctrl+PgUp). Moves the selected object forward one position. If the selected
object is in front of all other objects on the active layer, it is moved to the layer above.

Back One (Ctrl+PgDn). Moves the selected object behind one position. If the selected object
Is behind all other objects on the selected layer, it is moved to the layer below.

In_Front of. Moves the selected object in front of the object that you click in the drawing
window.

Behind. Moves the selected object behind the object that you click in the drawing window.
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Combine (Ctrl+L). Combining two or more objects creates a single object with common fill
and outline attributes. You can combine rectangles, ellipses, polygons, stars, spirals, graphs,
or text so that they are converted to a single curve object. If you need to modify the attributes
of an object that has been combined from separate objects, you can break apart the combined
object. You can extract a sub path from a combined object to create two separate objects. You
can also weld two or more objects to create a single object.

Break Apart (Ctrl+K). If you break apart a combined object that contains artistic text, the
text breaks apart into lines first, and then into words. Paragraph text breaks into separate
paragraphs.

Group Objects (Ctrl+G). When you group two or more objects, they are treated as a single
unit but retain their individual attributes. Grouping lets you apply the same formatting,
properties, and other changes to all the objects within the group at the same time. In addition,
grouping helps prevent accidental changes to the position of an object in relation to other
objects. You can also create nested groups by grouping together existing groups.
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Ungroup Objects (Ctrl+U). Breaks a group into individual objects, or a nested group into
multiple groups.

Ungroup All Objects. Breaks one or more groups into individual objects, including objects
within nested groups.

Hide Object. When an object is hidden, the object name appears grayed out in the Object
Manager docker, and an icon is displayed beside the name.

Show Object. When an object is show, the object name appears grayed out in the Object
Manager docker, and an icon is displayed beside the name.
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Lock Object. Locking an object prevents you from accidentally moving, sizing, transforming,
filling, or otherwise changing it. You can lock single, multiple, or grouped objects. To change
a locked object, you need to unlock it first. You can unlock one object at a time, or all locked
objects at the same time.
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Unlock Object. You can also unlock an object by right-clicking it and then clicking Unlock
object.

Unlock All Object. This option used to you will make all objects unlocked by this option.

Shaping. This command is used to make some typical and difficult shapes our object.

Weld Object. You can create irregular shapes by welding and intersecting objects. You can
weld or intersect almost any object, including clones, objects on different layers, and single
objects with intersecting lines. However, you cannot weld or intersect paragraph text,
dimension lines, or masters of clones. You can weld objects regardless of whether they overlap
each other. If you weld objects that do not overlap, they form a weld group that acts as a single
object. In both cases, the welded object takes on the fill and outline attributes of the target
object.

Trim _Object. Trimming creates irregularly shaped objects by removing object areas that
overlap. You can trim almost any object, including clones, objects on different layers, and
single objects with intersecting lines. However, you cannot trim paragraph text, dimension
lines, or masters of clones. CorelDraw lets you trim objects in different ways. You can use a
front object as the source object to trim an object behind it, as well as use the back object to
trim a front object. You can also remove hidden areas of overlapping objects, so that only the
visible areas remain in the drawing. Removing the hidden areas can reduce file size when you
convert vector graphics to bitmaps.
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Intersect Object. Intersecting creates an object from the area where two or more objects
overlap. The shape of this new object can be simple or complex, depending on the shapes you
intersect. The new object’s fill and outline attributes depend on the object you define as the
target object. The new object, which is created from the overlapping parts of the source and
target object, has the fill and outline properties of the target object. You can also intersect
objects by selecting the source and target objects and clicking the Intersect button on the
property bar.
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Simplify. This command is used to remove the object from the object.

Front Minus Back. Removes the back object from the front one.

Front Minus Front. Removes the front object from the back one.

Convert To Curves (Ctrl+Q). A curve object has nodes and control handles, which you can
use to change the object’s shape. A curve object can be any shape, including a straight or
curved line. An object’s nodes are the small squares that appear along the object’s outline. The
line between two nodes is called a segment. Segments can be curved or straight. Each node
has a control handle for each curved segment connected to it. Control handles help you adjust
the curve of a segment. Most objects that are added to a drawing are not curve objects, with
the exception of spirals, freehand lines, and Bézier lines. Therefore, if you want to customize
the shape of an object or text object, it is recommended that you convert it to a curve object.

Convert Outline To Objects (Ctrl+Shift+Q). This command is used to change the outline
any object by using shape tool then we have to make it convert to curves.

Join Curve. You can join the start and end nodes of an open path such as a line to create a
closed object. This feature is useful for filling an object with color because you can apply fills
only to the inside of closed objects. For information about applying fills, see Filling objects..

Overprint Fill & Outline. You can set a group of objects to overprint. You can allow text to
overprint overlying objects. You can also overprint bitmaps; or each vector object’s fill, or
outline, or both. In addition, you can overprint specific color separations and specify in which
order they will print, as well as whether you want to overprint graphics, or text, or both.

Overprint Properties. The Object properties docker presents object-dependent formatting
options and properties, letting you modify object settings from one location. For example, if
you create a rectangle, the Object properties docker automatically presents outline, fill,
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transparency, and corner formatting options, as well as the rectangle’s properties. If you create
a text frame, the docker instantly displays character, paragraph, and frame formatting options,
as well as the text frame’s properties. You can navigate quickly to the properties that you want
to modify by using the controls at the top of the Object properties docker. In addition, two
view modes are available: Scroll and Tab. Scroll mode displays all relevant object properties,
letting you scroll to the options you want. Tab mode displays only one group of object
properties at a time, hiding the other options. For example, you can view only fill options, and
then click the Outline button to view only outline options.
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Chapter-8. Effects Menu. (Alt+C).
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Adjust Color. By adjusting color and tone, you can restore detail lost in shadows or highlights,
remove color casts, correct underexposure or overexposure, and generally improve the quality
of the bitmaps. You can also correct color and tone quickly by using the Image Adjustment
Lab. For more information, see Using the Image Adjustment Lab.

Contrast Enhancement. Let’s you adjust the tone, color, and contrast of a bitmap while
preserving shadow and highlight detail. An interactive histogram lets you shift or compress
brightness values to printable limits. The histogram can also be adjusted by sampling values
from the bitmap.

Local Equalization. Let’s you enhance contrast near edges to reveal detail in both light and
dark regions. You can set the height and width around the region to accentuate contrast.
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Sample Target Balance. Let’s you adjust color values in a bitmap with sample colors taken
from the image. You can choose sample colors from the dark, midtone, and light ranges of an
Image and apply target colors to each of the sample colors.

Tone Curve. Let’s you perform color corrections precisely, by controlling individual pixel
values. By changing pixel brightness values, you can make changes to shadows, midtone, and
highlights. For more information, see using the Tone Curve filter.
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Brightness And Contrast Intensity (Ctrl+B). Let’s you adjust the brightness of all colors
and the difference between light and dark areas.
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Color Balance (Ctrl+Shift+B). Let’s you add cyan or red, magenta or green, and yellow or
blue to selected tones in a bitmap.

Gama. Let’s you accentuate detail in low contrast areas without affecting shadows or
highlights.

Hue Saturation Lightness (Ctrl+Shit+U). Let’s you adjust the color channels in a bitmap and
change the position of colors in the spectrum. This effect allows you to change colors and their
richness, as well as the percentage of white in an image.

Selective Color. Let’s you change color by changing the percentage of spectrum CMYK
process colors from the red, yellow, green, cyan, blue, and magenta color spectrums in a
bitmap. For example, decreasing the percentage of magenta in the reds spectrum results in a
color shift toward yellow.

Replace Color. Let’s you replace one bitmap color with another color. A color mask is created
to define the color to be replaced. Depending on the range you set, you can replace one color
or shift an entire bitmap from one color range to another. You can set the hue, saturation, and
lightness for the new color.

Desaturation Color. Lets you reduce the saturation of each color in a bitmap to zero, remove
the hue component, and convert each color to its grayscale equivalent. This creates a grayscale
black-and-white photo effect without changing the color model.
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Channel Mixer. Lets you mix color channels to balance the colors of a bitmap. For example,
If a bitmap has too much red, you can adjust the red channel in an RGB bitmap to improve
image quality.
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Transform. You can transform the color and tone of an image to produce a special effect. For
example, you can create an image that looks like a photographic negative or flatten the
appearance of an image. To transform the color and tone of images, you can use the following
effects.

Delnterlace. Let’s you remove lines from scanned or interlaced images.

Invert Colors. Let’s you reverse the colors of an image. Inverting an image creates the
appearance of a photographic negative.

Posterize Colors. Let’s you reduce the number of tonal values in an image. Posterize removes
gradations and creates larger areas of flat color.

Correction. This command is used to you can adjust and scratches to our object.

Artistic Media. You can control how a sprayed line appears by adjusting the spacing between
objects, so they are closer or farther apart from each other. You can also vary the order of
objects in the line. For example, if you are spraying a series of objects that includes a star, a
triangle, and a square, you can change the spray order so that the square appears first, followed
by the triangle and then the star. CorelDraw also lets you shift the position of objects in a
sprayed line by rotating them along the path or offsetting them in one of four different
directions: alternating, left, random, or right. For example, you can choose a left offset
direction to align the objects you spray to the left of the path. You can also choose preset lines
from the Artistic media docker. You can open the Artistic media docker by clicking Effects »
Artistic media.
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Blend. After you create a blend, you can copy or clone its settings to other objects. When you
copy a blend, the object takes on all the blend-related settings, except for the outline and fill
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attributes. When you clone a blend, changes you make to the original blend (also called the
master) are applied to the clone.

Contour (Ctrl+F9). After contouring an object, you can copy or clone its contour settings to
another object. You can also change the colors of the fill between the contour lines and the
contour outlines themselves. You can set a color progression in the contour effect, where one
color blends into another. The color progression can follow a straight, clockwise, or
counterclockwise path through the color range of your choice.

Envelop (Ctrl+F7). You can edit an envelope by adding and positioning its nodes. Adding
nodes gives you more control over the shape of the object contained in the envelope.
CorelDraw also lets you delete nodes, move multiple nodes simultaneously, change nodes
from one type to another, and change a segment of an envelope to a line or curve. For more
information about the different types of nodes, see Using curve objects.

Extrude. After you create an extrusion, you can copy or clone its attributes to a selected object.
Cloning and copying transfer the extrusion attributes of an extruded object to another.
However, the cloned extrusion settings cannot be edited independently from the master.
Another way in which you can give an object a three-dimensional appearance is by applying
a beveled edge to an extrusion. A bevel creates the illusion that an object’s extruded edges are
cut on an angle. You can specify the angle and depth values of the bevel to control the effect.

Bevel. The Emboss bevel effect is achieved by creating two duplicates of the object. The
duplicates are offset in opposite directions: one toward the light source and the other away
from the light source. The color of the duplicate placed toward the spotlight is a blend of the
spotlight and object colors and depends on the light intensity. The color of the duplicate placed
away from the spotlight is a 50 percent blend of the shadow and object colors.
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Lens (Alt+F3). Lenses change how the object area beneath the lens appears, not the actual
properties and attributes of the objects. You can apply lenses to any vector object, such as a
rectangle, ellipse, closed path, or polygon. You can also change the appearance of artistic text
and bitmaps. When you apply a lens over a vector object, the lens itself becomes a vector
image. Likewise, if the lens is placed over a bitmap, the lens also becomes a bitmap.
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Add Prospective. Perspective distortions usually occur when you take pictures of tall or wide
objects, and the camera sensor is at an angle to the objects. As a result, the photographed
objects may appear to be leaning or to be at an angle. Adjusting the vertical perspective helps
straighten leaning objects; adjusting the horizontal perspective helps with angled objects.
Often, you may need to adjust both the vertical and horizontal perspectives for best results.
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Chapter-9. Bitmaps Menu. (Alt+B).
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Convert To Bitmap. Converting a vector graphic or object to a bitmap lets you apply special
effects to the object with CorelDraw. The process of converting a vector graphic to a bitmap
Is also known as "rasterizing.". When you convert the vector graphic, you can select the color
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mode of the bitmap. A color mode determines the number and kind of colors that make up the
bitmap, so the file size is also affected. For more information about color modes, see changing
the color mode of bitmaps.

Resolution. The amount of detail that an image file contains, or that an input, output, or display
device is capable of producing. Resolution is measured in dpi (dots per inch) or ppi (pixels per
inch). Low resolutions can result in a grainy appearance; high resolutions can produce higher
quality images but result in larger file sizes.

Color Mode. A system that defines the number and kind of colors that make up an image.
Black-and-white, grayscale, RGB, CMYK, and paletted are examples of color modes.

Dithered. A process used to simulate a greater number of colors when only a limited number
of colors are available. Simulates a greater number of colors than those available. This option
Is available for images that use 256 or fewer colors.

Always Overprint Black. Overprints black when black is the top color. Enabling this option
prevents gaps from appearing between black objects and underlying objects when you print
bitmaps.

Anti-Aliasing. Smooths the edges of the bitmap.

Transparent Background. Makes the background of the bitmap transparent.

Auto Adjust. By adjusting color and tone, you can restore detail lost in shadows or highlights,
remove color casts, correct underexposure or overexposure, and generally improve the quality
of the bitmaps. You can also correct color and tone quickly by using the Image Adjustment
Lab. For more information, see Using the Image Adjustment Lab.

Image Adjustment Lab. The Image Adjustment Lab consists of automatic and manual
controls, which are organized in a logical order for image correction. By starting in the upper-
right corner and working your way down, you can select only the controls you need to correct
the problems specific to your image. It is best to crop or retouch any areas of the image before
beginning the color and tone corrections. Temperature slider — lets you correct color casts by
"warming" or "cooling" the color in an image to compensate for the lighting conditions at the
time the photo was taken. For example, to correct a yellow color cast caused by taking a photo
indoors in dim incandescent lighting, you can move the slider toward the blue end to increase
the temperature values (based on degrees Kelvin). Lower values correspond to low lighting
conditions, such as candlelight or light from an incandescent light bulb; these conditions cause
an orange cast. Higher values correspond to intense lighting conditions, such as sunlight; these
conditions cause a blue cast. Tint slider — lets you correct color casts by adjusting the green
or magenta in an image. You can add green by moving the slider to the right; you can add
magenta by moving the slider to the left. Moving the Tint slider after using the Temperature
slider lets you fine-tune an image.
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Straighten Image. The Straighten image dialog box lets you correct lens distortions and
straighten bitmap images quickly. This feature is useful for straightening photos that were
taken or scanned at an angle or contain lens distortions.

Rotating And Previewing. The Straighten image dialog box lets you rotate an image by
moving a slider, typing a rotation angle, or using the arrow keys. You can specify a custom
rotation angle from -15 to 15 degrees. You can use the preview window to dynamically
preview the adjustments that you are making. If you want to change the orientation of the
Image before straightening it, you can start by rotating the image 90 degrees clockwise and 90
degrees counterclockwise.

Cropping. By default, the straightened image is cropped to the cropping area that is displayed
in the preview window. The final image has the same aspect ratio as the original image, but it
has smaller dimensions. However, you can preserve the original width and height of the image
by cropping and resampling the image.

Edit Bitmap. You can access Corel PHOTO-PAINT, a complete image-editing application,
from within CorelDraw. When you finish editing a bitmap, you can quickly resume your work
with CorelDraw. To send a bitmap to Corel PHOTO-PAINT, you can click the Edit bitmap
button on the property bar, or you can use the Edit bitmap command from the Bitmaps menu.
You can also enable an option that lets you access Corel PHOTO-PAINT by double-clicking
a bitmap. You can also use this procedure to edit groups of bitmaps. Corel PHOTO-PAINT
opens the group of bitmaps as separate objects. If the bitmaps in the group have different color
modes, you are prompted to change the color mode of all bitmaps in the group to the color
mode of the bottom-most bitmap.

Crop Bitmap. To cut unwanted areas of an image without affecting the resolution of the part
that remains. To crop a bitmap into a rectangular shape, you can use the crop tool. For more
information, see to crop objects. To crop a bitmap into an irregular shape, you can use the
shape tool and the crop bitmap command.

Resample. If you want to maintain the file size, enable maintain original size check box. When
this check box is enabled, the resolution of the bitmap is automatically adjusted as you change
the image dimensions. You can maintain the proportions of the bitmap by enabling the
maintain aspect ratio check box and typing a value in either the width or height box. You can
also resample the bitmap as a percentage of its original size by typing values in the width %
and height % boxes.

Mode. You can achieve better color fidelity by choosing the palette you want to use when you
change an image to a paletted bitmap or when you export a GIF or PNG. For example, the
standard color palette provides more colors than necessary for an image with a limited range.
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Inflate Bitmap. In the Inflate to boxes, type the number of pixels that should make up the
dimensions of the inflated bitmap. In the Inflate by boxes, type the percentages by which to
inflate the original bitmap.
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Quick Trace. You can trace a bitmap in one step by using the Quick Trace command.
Alternatively, you can choose a suitable tracing method and preset style and then use the Power
TRACE controls to preview and adjust the traced results. CorelDraw offers two methods for
tracing bitmaps: Centerline Trace and Outline Trace. The Centerline Trace method uses
unfilled closed and open curves (strokes) and is suitable for tracing technical illustrations,
maps, line drawings, and signatures. This method is also referred to as "'stroke tracing.

Centre Line Trace (Technical Hlustration). To trace black-and-white illustrations with thin,
faint lines.

Technical lllustration. To trace black-and-white sketches with thick, prominent lines. If
necessary, adjust the traced results by using the controls of the Power TRACE dialog box.

Outline Trace. Line art — lets you trace black-and-white sketches and illustrations.

Logo. Lets you trace simple logos with little detail and few colors

Detailed Logo. Let you trace logos that contain fine detail and many colors.

Clipart. Lets you trace ready-to-use graphics that vary according to their amount of detail and
number of colors.

Low Quality Image. Lets you trace photos that lack fine detail (or that contain fine detail that
you want to ignore).

High Quality Image. Lets you trace high-quality, highly detailed photos.
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3D Effects. Lets you create the illusion of depth. Effects include Emboss, Page Curl, and
Perspective.

3D Effects — Page Curl. This command is use to convert graphics image in to 3d shape. Just
like rotate, perspective, page curl, sphere etc.
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Art Strokes — Cubist. Let’s you apply hand-painted techniques. Effects include Crayon,
Impressionist, Pastels, Watercolor, and Pen & Ink.
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Blur — Gaussian Blur. Let’s you blur an image to simulate movement, speckling, or gradual
change. Effects include Gaussian Blur, Motion Blur, Smart Blur, and Zoom.
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Camera. Lets you simulate effects produced by various camera lenses. Effects include
Colorize, Photo Filter, Sepia Toning, and Time Machine, which lets you walk your image back
through history to recreate some popular photographic styles from the past.

=

Color Transform — Halftone. Let’s you blur an image to simulate movement, speckling, or
gradual change. Effects include Gaussian Blur, Motion Blur, Smart Blur, and Zoom.
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Contour. Lets you highlight and enhance the edges of an image. Effects include Edge Detect
and Trace Contour.

Creative — Vignette. Let’s you apply various textures and shapes to an image. Effects include
Fabric, Glass Block, Crystalize, Vortex, and Stained Glass.

IE] CorelDRAW X4 - [DA\software\Vinod sir New Site\safi\vig.cdr]
i File Edit ew Layout Arrange Tex Window Help
O e =N SE i SR B Gy B - &g 3% v snapto - =
(} Arial w || 24pt LY B & U E‘
283% vl ® |8 |l g a =g x:2.296 " W 8. 694 20.4 |% [@] 0.0 o T i [ — )
L & @ g K rlioeez e e o Bg 42 | [ EditBitmap... [ Trace Bitmap
. 1 0 1 2 3 4 5 3 7 8 9 10 11 12 13
-\__I I [ il ] ] 1 I [ o] PR | ] I I 1 I [
T
g - - Vignette “
|
. m o 5
1_2'(-‘ ] Color Shape Adjust
=, = ®) EBlack () Ellipse Offset: 98
t\A‘ 1 White -:?Z- Cirde . =
Jﬁ ] Other (_J Rectangle
O =5 ] () Square
Ll -
Q|
Q,| ™
g‘ Preview = Reset | Cancel Help
AN,
L] —aifmm| Apply Vignette Effects In The Objects
A
@&, [ o s
2 - u

Custom - Alchemy. Lets you apply a wide range of effects to your image. For example, you
can transform your image into an artistic media painting by applying brushstrokes (Alchemy
effect) or add texture and patterns to an image (Bump-map effect).
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Distort — Swirl. Let’s you distort image surfaces. Effects include Ripple, Blocks, Swirl, and
Tile.
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Apply Swirl Effects In The Image.
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Noise — Add Noise. Let’s you modify the graininess of an image. Effects include Add Noise,
Remove Moire, and Remove Noise.
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Sharpen. Lets you add a sharpening effect to focus and enhance edges. Effects include
Adaptive Unsharp, High Pass, and Unsharp Mask.
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Texture - Cobblestone. Lets you add texture to an image by simulating a variety of surfaces,
such as cobblestone, elephant skin, plastic, and relief sculpture.
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Plug-In. Lets you use a third-party filter to apply effects to bitmaps in CorelDraw. An installed
plug-in appears at the bottom of the Bitmaps menu. Adding plug-in filters to CorelDraw
provides additional features and effects that you can use to edit images. You can add plug-in
filters, and you can remove them when you no longer need them.

Chapter-10. Text Menu. (Alt+X).

mCDre\DRAWXE(M-E\t]-Unt\t\ad-'\ @" - B X
File  Edit View Layout Object Effects E\tmapsITe:_(t |Iab|e Tools  Window Help

Character Formatting. You can choose from a list of common font combinations to apply a
font set to the selected text. When a visitor’s browser displays that text, it moves down the list
of assigned fonts until it finds one installed on his computer. You can create your own
combination of paragraph fonts by going to the submenu and choosing edit font list. Pick a
new font for your text.

Font Size. Font size is measurement in point the larger font size approximately 72 point in an
inch. You want to change font formatting at the same time. You can change font size font
dialog box.

Font Style. The Adobe Type | Font (PFB) is a file format that stores Adobe Type 1 fonts.
Most Type 1 fonts are single master fonts that permit only style editing; for example, Roman,
italic, bold. A single master Type 1 font contains two files: a Printer Font Metrics (PFM) file
and a Printer Font Binary (PFB) file.
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Bold Font. You can make your text matter bold. The selected text will be modified in the
document.

Italic Font. You can italicize your text matter. The selected text will be modified in the
document.

Underline Font. You can underline your text matter. The selected text will be modified in the
document.

Text Color. This option is used to select text matter and change text matter colour. Your colour
choices aren't limited to the drop-down menu that appears. Select more colours. At the bottom
of the menu to access the colours dialog box. Choose the colour you want, then click ok. Select
the font colour you want to use. The font colour will change in the document.

Caps Change the selected text to uppercase, lowercase, or other common capitalization. You
want to change its case to display the change case dialog box choose the option you want and
click ok. A drop-down menu will appear. Select the desired case option from the menu.

Subscript. Type very small letters just below the line of text.

Superscript. Type very small letters just above the line of text.

Paragraph. CorelDraw lets you align text in various ways. You can align paragraph text
horizontally and vertically in relation to its text frame. You can align paragraph text with the
baseline grid. For more information, see Aligning text by using the baseline grid. You can also
align text to a selected object.

No Horizontal Alignment. Applies the default alignment setting.

Align Left. Aligns text with the left side of the text frame or the bounding box of artistic text.
Centre. Centers text within the text frame.

Align Right. Aligns text with the right side of the text frame and the bounding box of artistic
text.

Full Justify. Aligns text, with the exception of the last line, with the left and right sides of the
text frame.

Force Justify. Aligns text, including the last line, with the left and right sides of the text frame.

Left Line Indent. Set the distance to indent the paragraph text except the first line relative to
the left side of the text frame.

Right Line Indent. Set the distance to indent the paragraph text except the first line relative
to the right side of the text frame.

First Line Indent. Set the distance to indent the first line of paragraph text relative to the left
side of the text frame.
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Before Paragraph Spacing. Specify the amount of space to insert above the paragraph.

After Paragraph Spacing. Specify the amount of space to insert below the paragraph.

Line Spacing. Choose how much space appears between lines of text between paragraphs. To
apply the same spacing to whole document use paragraph spacing option on the design table.
Line spacing is the amount of space between lines in a paragraph. By default paragraph are
single spacing. You might want to double space a school paper or a draft report. 1.5 line
spacing better than single spacing because it can make the text a little easier to read.

Character Spacing. You can improve text readability by adjusting the character and word
spacing. When letters or words are too close together, or too far apart, they become difficult
to read. CorelDraw offers you different tools for controlling text spacing. You can change the
spacing between characters (also known as "letter spacing™) in a block of text. For example,
fully justifying a block of text may insert too much space between characters, which creates a
visual imbalance. To improve readability, you can decrease the character spacing.

Number of Columns. You can lay out text in columns. Columns are useful for designing text-
intensive projects, such as newsletters, magazines, and newspapers. You can create columns
of equal or varying widths and gutters. You can also apply right-to-left text flow to the columns
for bidirectional (bidi) text, such as Arabic and Hebrew (Note that this option is available only
for certain languages).

Align Base Line Grid. You can align text within a frame or in different frames by using the
baseline grid. This is useful, for example, when you want to align two or more text frames that
contain different fonts, font sizes, and spacing. All objects can snap to the baseline grid; only
text frames can align to the baseline grid. Snapping is turned on or off for all objects (it’s a
grid setting). Alignment is turned on or off for individual frames (it’s a text frame setting). For
information about displaying or hiding the baseline grid, turning snapping on or off, changing
the grid color, and setting the line spacing, see Setting up the baseline grid.

Tabs. You can modify existing tab stops by changing their alignment. You can also add
trailing leader characters, so that dots, or other characters, automatically precede the tab stops.
In addition, you can add new tab stops and remove existing tab stops. Indenting changes the
space between a text frame and the text that it contains. You can add and remove indents
without deleting or retyping text. You can indent an entire paragraph, the first line of a
paragraph, or all lines of a paragraph except the first line (a hanging indent). You can also
indent from the right side of the text frame.

Columns. Split your text into two or more columns. You can also choose width and spacing
of your columns or use one of the pre-set formats. But some types of documents—Iike
newspaper articles, newsletters, and flyers—are often written in column format. Word also
allows you to adjust your columns by adding column breaks.
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Bullets. You can use bulleted lists to format information. You can wrap text around bullets,
or you can offset a bullet from text to create a hanging indent. CorelDraw lets you customize
bullets by changing their size, position, and distance from text. You can also change the
spacing between items in a bulleted list.

Drop Cap. Applying drop caps, also known as initial caps, to paragraphs enlarges the initial
letter and insets it into the body of text. You can customize a drop cap by changing different
settings. For example, you can change the distance between the drop cap and the body of text,
or specify the number of lines of text that you want to appear next to the drop cap. You can
remove the drop cap at any point without deleting the letter.

Font Playground. Font Playground lets you view the same sample text in different fonts and
sizes to help you choose fonts for your project. You can preview preset text samples, or you
can type or paste text. In addition, you can view samples as single lines of text or multiline
text, and you can view a text sample as single lines of text in increasing font sizes.

Edit Text (Ctrl+Shift+T). CorelDraw lets you select text to edit specific characters or modify
it as an object. For example, you can select specific characters to change the font or select a
text object, such as a text frame, so you can move, resize, or rotate it.

Insert Character (Ctrl+F11). The Insert character docker is ideal for viewing and applying
the OpenType features provided by OpenType fonts. The default view shows a list of
characters in which the glyphs for individual characters appear grouped. Alternatively, you
can display a longer list that shows available glyphs at a glance.

Insert Formatting Code. You can insert formatting codes, such as em dashes and
nonbreaking spaces. In some programs, formatting codes are also known as "symbols." The
following table lists the available formatting codes and their corresponding keyboard
shortcuts.

Paragraph Text Frame. By default, text frames have a fixed size, regardless of how much
text you add to them. You can increase or decrease the frame size, so that the text fits in the
frame. If you add more text than a frame allows, the text continues past the lower-right border
of the text frame, but remains hidden. The color of the frame turns red to alert you that there's
additional text. You can fix the overflow manually by increasing the frame size, adjusting the
text size, adjusting the column width, or linking the frame to another text frame. For more
information, see combining and linking paragraph text frames.

Fit Text In To Path. After you fit text to a path, you can adjust the text position relative to
that path. For example, you can mirror the text horizontally, vertically, or both. Using tick
spacing, you can specify an exact distance between the text and the path. CorelDraw treats text
fitted to a path as one object; however, you can separate the text from the object if you no
longer want it to be part of the path. When you separate text from a curved or closed path, the
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text retains the shape of the object to which it was fitted. You can also modify the text and
path properties independently.
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Straighten Text. If your text is in angle or rotate from then us use straighten line.

Use Hyphenation. Hyphenation can be used to break a word if the entire word does not fit at
the end of a line. You can hyphenate automatically by using a preset hyphenation definition in
combination with your own hyphenation settings. You can set the minimum number of
characters before and after a hyphen. You can also specify the number of characters in the "hot
zone," which is the area at the end of a line where hyphenation can occur.

Change Case. CorelDraw lets you change the text case of artistic and paragraph text. For
example, you can apply small caps to acronyms so they visually blend with the text. If you
apply default capitalization, the text stands out too much and impacts the readability. In the
following example, the acronym "A.M." is shown with both the default uppercase and small
caps applied. You control the case of words, sentences, or paragraphs of selected text. For
example, you can apply title case to selected text to capitalize the initial letter of every word.
This is a useful formatting technique for headings, such as book or chapter titles. You can
automatically convert text to lowercase or uppercase without deleting or retyping letters. For
example, if you accidentally pressed the Caps Lock key and added uppercase text, you can
convert the text to lowercase without retyping it.

Text Static. You can check text statistics to count text elements, including the number of lines,
words, characters, and the names of the fonts and styles used. You can display statistics either

93|Page



Vinod Computer Institute Mehnagar Azamgarh UP.

for selected text objects or for the entire drawing. If no text is selected, all text elements in the
drawing, including tab and space characters, are counted.
Chapter-11. Table Menu (Alt+T).

Y CorelDRAW X8 (64-Bit) - Untitled-1 B - B X
File Edit View Layout Object Effects Bitmaps Text | Table | Tools Window Help

Create New Table. Insert Table. To insert more than one column or row at the same time,
select as many of columns or rows as you want to add before you click the insert control. Add
a table to a word document, including using the table grid, using custom controls with the
insert table dialog, or drawing a table with complex rows and columns.

Convert Text To Table. Split a single column of text into multiple columns. You can separate
a column of full name into separate first and last name columns. You choose how to split it up
fixed width or split at each comma period or other character.

Convert Table To Text. If you no longer want table text to appear in a table, you can convert
the table text to paragraph text. For more information about converting text to a table, see to
create a table from text.

Commas. Replaces each column with a comma and replaces each row with a paragraph
marker.

Tabs. Replaces each column with a tab and replaces each row with a paragraph marker.
Paragraph. Replaces each column with a paragraph marker.

User Defined. Replaces each column with a specified character and replaces each row with a
paragraph marker.

Insert Row. Insert a single row selected the row or a cell in the row above which you want to
insert the new row. If you want to insert multiple rows firstly you have selected the rows above
which you want to insert rows.

Insert Column. Insert a single column selected the column or a cell in the column immediately
to the right of where you want to insert the new column. If you want to insert multiple column
firstly you have selected the column immediately to the right of where you want to insert new
columns.

Select. You must select a table, table rows, table columns, or table cells before you insert rows
or columns, change the table border properties, add a background fill color, or edit other table
properties. You can move selected rows and columns to a new location in a table. You can
also copy or cut a row or column from one table and paste it in another table. In addition, you
can move from one table cell to another when editing the table cell text, and you can set the
direction in which the Tab key lets you move around a table.
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Delete Row. Delete a single row selected the row or a cell in the row above which you want
to delete the new row. If you want to delete multiple rows firstly you have selected the rows
above which you want to delete rows.

Delete Column. Delete a single column selected the column or a cell in the column
immediately to the right of where you want to delete the new column. If you want to delete
multiple column firstly you have selected the column immediately to the right of where you
want to delete new columns.

Distribute Row & Column. You can resize table cells, rows, and columns. In addition, if you
previously changed the sizes of some rows or columns, you can redistribute all rows or all
columns so that they are the same size.

Merge Cells (Ctrl+M). You can change how a table is configured by merging adjacent cells,
rows, and columns. If you merge table cells, the formatting of the upper-left cell is applied to
all merged cells. Alternatively, you can unmerge cells that were previously merged.

Split Row & Column. You can also split table cells, rows, or columns. Splitting lets you create
new cells, rows, or columns without changing the size of the table.

Unmerge. Select the cell that you want to unmerge.
Chaptr-12. Tools Menu (Alt+O).
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Customization. Corel customization features let you modify the menu bar and the menus it
contains. You can change the order of menus and menu commands; add, remove, and rename
menus and menu commands. You can search for a menu command if you do not remember
the menu in which it belongs. You can also reset menus to the default setting. The
customization options apply to the menu bar menus as well as to shortcut menus that you
access by right-clicking.

Color Management. Different tools are used during the process of creating and sharing a
document. For example, you may start with a file that was created in another application or
Import an image that was captured by a digital camera or scanner. After completing the
document, you may print it or email it to a colleague for review. Each of the tools that you use
in your workflow has a different way of interpreting color. In addition, each tool has its own
range of available colors, called a color space, which is a set of numbers that define how each
color is represented.

Chapter-13. Window Menu. (Alt+W).

&Y CorelDRAW X8 (64-Bit) - Untitled-1 E - B X
Eile Edit View Layout Object Effects Bitmaps Text Table Tools | Window | Help

New Window. Open a second window for your document so you can work in different place
at the same time.

Close Window (Ctrl+F4). If you are unable to close a document, you may have a task, such
as printing or saving, in progress or a task that has failed. Please refer to the status bar to view
the status of a task. You can also close a drawing by clicking Window »Close window.

Close All. You can also close all drawings by clicking Window »Close all.

Cascade. Multiple drawings can be opened in a single drawing window, making it easy to
handle many drawings simultaneously. You can access each open drawing from its tab at the
top of the drawing window, and you can start new drawings. Arranges drawings so that they
overlap and the title bars are visible.

Tile Horizontally. Arranges drawings side by side.

Tile Vertically. Stacks drawings vertically.

Dock Window. Toolbars can be either docked or floating. Docking a toolbar attaches it to the
edge of the application window. Undocking a toolbar pulls it away from the edge of the
application window, so it floats and can be easily moved around.

Workspace. CorelDraw includes a collection of workspaces that are designed to help you
increase your productivity. A workspace is a configuration of settings that specifies how the
various command bars, commands, and buttons are arranged when you open the application.
You can choose a workspace from the Welcome Screen, or you can switch to a different

workspace from within the application.
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Dock Window. Dockers can be either docked or floating. A docked docker is attached to the
edge of the application window, a toolbar, or a palette. A floating docker is not attached to a
workspace element. If you open several dockers, they usually appear nested, with only one
docker fully displayed. You can quickly display a docker hidden from view by clicking the
docker’s tab.

Toolbar. Toolbars can be either docked or floating. Docking a toolbar attaches it to the edge
of the application window. Undocking a toolbar pulls it away from the edge of the application
window, so it floats and can be easily moved around.

Color _Palettes. Color palettes can be either docked or floating. Docking a color palette
attaches it to the edge of the application window. Undocking a color palette pulls it away from
the edge of the application window, so it floats and can be easily moved around.
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Welcome Screen. You can also access the Welcome screen by clicking the Welcome screen
button on the tab bar. If you want to hide the Welcome screen button from the tab bar, click
Tools »Options, click General in the Workspace list of categories, and disable the Show
Welcome Screen button on tab bar check box.
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Chapter-14. Corel Draw X7. Keyboard Shortcut Key.

Shortcut Key. Option.

l. Artistic Media.

Ctrl + Page Up. Back One.

Ctrl + K. Break Apart.

Ctrl + B. Brightness.

Ctrl + Enter. Bring Up Property Bar.
Ctrl + T. Character Formatting.
P. Center of Page.

Shift + F11. Color.

Ctrl + Shift + B. Color Balance.

Ctrl + L. Combine.

Ctrl +F9. Contour.

Ctrl + F8. Convert.

Ctrl + Shift + Q.

Convert Outline to Object Ctrl + Q.

Ctrl + Q. Convert to Outline.
Ctrl + C. Copy.

Ctrl + Insert. Copy.

Ctrl + X. Cut.

Shift + Delete. Cut.

Delete. Delete.

Ctrl + D. Duplicate.

Alt + Shift + D, Dynamic Guides.
Ctrl + Shift + T. Edit Text.

F1. Help.

Ctrl + F7. Envelop.

X. Eraser.

Ctrl + E. Export.

Ctrl + Numa2. Font Size Decrease.
Ctrl + Nums. Font Size Increase.
Ctrl + Page Up. Forward One.

F11. Fountain.

F5. Freehand.

F9. Full Screen Preview.
D. Graph Paper.

Ctrl + F5. Graphics and Text Styles.
Ctrl + G. Group.
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H. Hand

Ctrl + 1. Import.

Ctrl + F11. Insert Symbol Characters.
N. Interactive Fill.
Ctrl + N. New.

Page Down. Next Page.

Ctrl + V. Paste.

Shift + Insert. Paste.

F12. Pen.

Y. Polygon.

Alt + F1. Position.

Page Up. Previous Page.
Ctrl + P. Print.

F6. Rectangle.

Alt + F8. Rotate.

Ctrl + Shift + S. Save As.

Ctrl + S. Save.

Alt + F9. Scale.

Ctrl + A. Select All Object.
F10. Shape.

Alt + Z. Shape to Object.
Ctrl + F12. Spelling Check.
A. Spiral.

F8. Text.

Z. Zoom.

File (Alt+F).

New. Ctrl + N.

Open. Ctrl + O.

Save. Ctrl + S.

Save As. Ctrl + Shift + S.
Import. Ctrl + 1.

Export. Ctrl + E.

Print. Ctrl + P.

Exit. Alt + F4.

Edit (Alt+E).

Undo. Ctrl + Z.

Redo. Ctrl + Shift + Z.
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Repeat Ctrl + R.
Cut. Ctrl + X.
Copy. Ctrl + C.
Paste. Ctrl + V.
Delete. Delete.
Symbol > Symbol Manager. Ctrl + F3.
Duplicate. Ctrl + D.
Step and Repeat. Ctrl + Shift + D.
Find and Replace > Find Objects. Ctrl + F.
Object Properties. Alt + Enter.
View (Alt+V).

Full-Screen Preview. Fo.

View Manager. Ctrl + F2.
Snap to > Document Grid. Ctrl + Y.
Snap to > Objects. Alt + Z.
Dynamic Guides. Alt + Shift + D,
Alignment Guides. Alt + Shift + A,
Arrange (Alt+A).

Transformations > Position. Alt + F7.
Transformations > Rotate. Alt + F8.
Transformations > Scale. Alt + F9.
Transformations > Size. Alt + F10.
Align and Distribute > Align Left. L.

Align and Distribute > Align Right. R.

Align and Distribute > Align Top. T.

Align and Distribute > Align Bottom. B.

Align and Distribute > Align Centers £
Horizontally. '

Align and Distribute > Align Centers C

Vertically. '

Align and Distribute > Center to Page. P.

Order > To front of Page. Ctrl + Home.
Order > To Back of Page. Ctrl + End.

Order > To Front of Layer.

Shift+ Page Up.

Order > To Back of Layer.

Shift+ Page Down.

Order > Forward One.

Ctrl + Page Up.

Order > Backward One.

Ctrl + Page Down.

Group.

Ctrl + G.
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Ungroup. Ctrl + U.
Combine. Ctrl + L.
Break Apart. Ctrl + K.
Convert to Curves. Ctrl + Q.

Convert Outline to Object.

Ctrl + Shift + Q.

Effects (Alt+C).

Adjust > Brightness/Contrast/Intensity.

Ctrl + B.

Adjust > Color Balance.

Ctrl + Shift + B.

Adjust > Hue/saturation/Lightness.

Ctrl + Shift + U.

Contour. Ctrl + F9.
Envelope. Ctrl + F7.

Lens. Ctrl + F3.

Text (Alt+X).

Text Properties. Ctrl + T.

Edit Text. Ctrl + Shift + T.
Insert Symbol Character. Ctrl + F11.
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